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Product notice

This user guide describes features that are
common to most models. Some features
may not be available on your computer.

To obtain the latest information in this
guide, contact support. For U.S. support, go
to http://www.hp.com/go/contactHP. For
worldwide support, go to
http://welcome.hp.com/country/us/en/
wwcontact_us.html.

Software terms

By installing, copying, downloading, or
otherwise using any software product
preinstalled on this computer, you agree to
be bound by the terms of the HP End User
License Agreement (EULA). If you do not
accept these license terms, your sole
remedy is to return the entire unused
product (hardware and software) within 14
days for a refund subject to the refund
policy of your place of purchase.

For any further information or to request a
full refund of the computer, please contact
your local point of sale (the seller).


http://www.hp.com/go/contactHP
http://welcome.hp.com/country/us/en/wwcontact_us.html
http://welcome.hp.com/country/us/en/wwcontact_us.html

Safety warning notice

/\ WARNING! To reduce the possibility of heat-related injuries or of overheating the computer, do not
place the computer directly on your lap or obstruct the computer air vents. Use the computer only on
a hard, flat surface. Do not allow another hard surface, such as an adjoining optional printer, or a soft
surface, such as pillows or rugs or clothing, to block airflow. Also, do not allow the AC adapter to
contact the skin or a soft surface, such as pillows or rugs or clothing, during operation. The computer
and the AC adapter comply with the user-accessible surface temperature limits defined by the
International Standard for Safety of Information Technology Equipment (IEC 60950).
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Welcome

After you set up and register the computer, it is important to take the following steps:

e Take a minute to browse the printed Windows 8 Basics guide to explore the new Windows®
features.

:{;’. TIP: To quickly return to the computer Start screen from an open app or the Windows desktop,

press the Windows logo key mm ONYour keyboard. Pressing the Windows logo key again will

return you to the previous screen.

e Connect to the Internet—Set up your wired or wireless network so that you can connect to the
Internet. For more information, see Connecting to a network on page 16.

e Update your antivirus software—Protect your computer from damage caused by viruses. The
software is preinstalled on the computer. For more information, see Using antivirus software

on page 80.
e Get to know your computer—Learn about your computer features. Refer to Getting to know

your computer on page 4 and Navigating using the keyboard, touch gestures and pointing
devices on page 24 for additional information.

e Find installed software—Access a list of the software preinstalled on the computer:

From the Start screen, type a, click Apps, and then select from the displayed options. For
details about using the software included with the computer, see the software manufacturer's
instructions, which may be provided with the software or on the manufacturer's website.

e Back up your hard drive—Create recovery discs or a recovery flash drive. See Backup and
recovery on page 93.
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Finding information

The computer comes with several resources to help you perform various tasks.

Resources

For information about

Setup Instructions poster

How to set up the computer

Help to identify computer components

Windows 8 Basics guide

Overview of using and navigating with Windows® 8.

Help and Support

To access Help and Support, type h, and then select
Help and Support.

To obtain the latest information in this guide, contact
support. For U.S. support, go to http://www.hp.com/go/
contactHP. For worldwide support, go to
http://welcome.hp.com/country/us/en/
wwcontact_us.html.

Operating system information
Software, driver, and BIOS updates
Troubleshooting tools

How to access support

Regulatory, Safety, and Environmental Notices

To access this guide, from the Start screen, select the
HP Support Assistant app, screen, select My
computer, and then select User guides.

Regulatory and safety information

Battery disposal information

Safety & Comfort Guide

To access this guide, from the Start screen, select the
HP Support Assistant app, select My computer, and
then select User guides.

—or—

Go to http://www.hp.com/ergo.

Proper workstation setup, posture, health, and work habits

Electrical and mechanical safety information

Worldwide Telephone Numbers booklet

This booklet is provided with your computer.

HP support telephone numbers

HP website

To obtain the latest information in this guide, contact
support. For U.S. support, go to http://www.hp.com/go/
contactHP. For worldwide support, go to
http://welcome.hp.com/country/us/en/

wwcontact us.html.

Support information
Ordering parts and finding additional help

Accessories available for the device

Chapter 1 Welcome
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Resources For information about

Limited Warranty* Warranty information

To access this guide, from the Start screen, select the
HP Support Assistant app, select My computer, and
then select Warranty and services.

—or —

Go to http://www.hp.com/go/orderdocuments.

*You can find the expressly provided HP Limited Warranty applicable to your product located with the user guides on your
computer and/or on the CD/DVD provided in the box. In some countries/regions, HP may provide a printed HP Limited
Warranty in the box. For some countries/regions where the warranty is not provided in printed format, you may request a
printed copy from http://www.hp.com/go/orderdocuments or write to:

e  North America: Hewlett-Packard, MS POD, 11311 Chinden Blvd., Boise, ID 83714, USA
e Europe, Middle East, Africa: Hewlett-Packard, POD, Via G. Di Vittorio, 9, 20063, Cernusco s/Naviglio (Ml), Italy
e  Asia Pacific: Hewlett-Packard, POD, P.O. Box 200, Alexandra Post Office, Singapore 911507

When you request a printed copy of your warranty, please include your product number, warranty period (found on your
service label), name, and postal address.

IMPORTANT: Do NOT return your HP product to the addresses above. For U.S. support, go to http://www.hp.com/go/
contactHP. For worldwide support, go to http://welcome.hp.com/country/us/en/wwcontact us.html.

Finding information
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2 Getting to know your computer

Top

TouchPad

Component

Description

(1

Left pointing stick button

Functions like the left button on an external mouse.

(2

Center pointing stick button

Functions like the center button on an external mouse.

3

Pointing stick

Moves the pointer and selects or activates items on the
screen.

4

Right pointing stick button

Functions like the right button on an external mouse.

(5

Right TouchPad button

Functions like the right button on an external mouse.

(6)

Center TouchPad button

Functions like the center button on an external mouse.

™

Left TouchPad button

Functions like the left button on an external mouse.

(®)

TouchPad zone

Moves the pointer and selects or activates items on the
screen.

9

TouchPad on/off button

Turns the TouchPad on and off when it is double-tapped.
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Lights

Component

Description

()

TouchPad light

e  Amber: The TouchPad is off.
e  Off: The TouchPad is on.

)

Caps lock light

On: Caps lock is on.

(3) I Power light e  On: The computer is on.
U e  Blinking: The computer is in the Sleep state.

e  Off: The computer is off or in Hibernation.

(4) Num Ik light On: Num lock is on.

(5) I[l: J}I Wireless light e  White: An integrated wireless device, such as a

I wireless local area network (WLAN) device and/or a
Bluetooth® device, is on.

e  Amber: All wireless devices are off.

(6) Mute light e  Amber: Computer sound is off.

s

e  Off: Computer sound is on.

@)

@

Web browser light

e  On: The computer is on.

e  Off: The computer is off.

(8)

&

Calculator light

e  On: The calculator function is on.

e  Blinking: The calculator has been activated.

Top
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Buttons and fingerprint reader (select models only)

0 P00

Component Description

1) I Power button e  When the computer is off, press the button to turn on
U the computer.

e  When the computer is in the Sleep state, press the
button briefly to exit Sleep.

e  When the computer is in Hibernation, press the button
briefly to exit Hibernation.

CAUTION: Pressing and holding down the power button
will result in the loss of unsaved information.

If the computer has stopped responding and Windows®
shutdown procedures are ineffective, press and hold the
power button for at least 5 seconds to turn off the computer.

To learn more about your power settings, see your power
options. From the Start screen, type power, select
Settings, and then select Power Options.

(2) {I J}l Wireless button Turns the wireless feature on or off but does not establish a
I wireless connection.

(3) ‘ ﬂ Volume mute button Mutes and restores speaker sound.

(4) @ Web browser button Opens the default Web browser.

(5) E Calculator button Activates the calculator function.

Chapter 2 Getting to know your computer



Component Description

(6) Fingerprint reader (select models only) Allows a fingerprint logon to Windows, instead of a
password logon.

(7) TouchPad on/off button Turns the TouchPad on and off when it is double-tapped.

Top



Keys

Component

Description

0

esc key

Displays system information when pressed in combination
with the fn key.

(2

Function keys

Execute frequently used system functions when pressed in
combination with the fn key.

NOTE: fn12 is for models with backlit keyboards.

@)

fn key

Executes frequently used system functions when pressed
in combination with a function key, the num Ik key, or the
esc key.

4

Windows logo key

Returns you to the Start screen from an open app or the
Windows desktop.

NOTE: Pressing the Windows logo key again will return
you to the previous screen.

(5

Windows applications key

Displays options for a selected object.

(6)

Integrated numeric keypad

When num |k has been enabled, it can be used like an
external numeric keypad.

M

num Ik key

Alternates between the navigational and numeric functions
on the integrated numeric keypad.
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Front

Component Description
(1) {ﬂ :} Wireless light Turns the wireless feature on or off but does not
I establish a wireless connection.
Power light e  On: The computer is on.

0

e  Blinking: The computer is in the Sleep state.

e  Off: The computer is off.

() ,

AC adapter/Battery light

e  White: The computer is connected to external
power and the battery is charged from 90 to 99
percent.

e  Amber: The computer is connected to external
power and the battery is charged from 0 to 90
percent.

e  Blinking amber: A battery that is the only available
power source has reached a low battery level.
When the battery reaches a critical battery level,
the battery light begins blinking rapidly.

e  Off: The battery is fully charged.

(4)

(<0

Hard drive light

e  Blinking white: The hard drive is being accessed.

e  Amber: HP 3D DriveGuard has temporarily
parked the hard drive.

(%)

Display release latch

Opens the computer.

(6)

Media Card Reader

Reads data from and writes data to digital memory
cards such as Secure Digital (SD).

@)

Speakers (2)

Produce SRS Premium Sound or SRS Premium Sound
PRO (select models only).

NOTE: To use the SRS Premium Sound software,
from the Start screen, type SRS, and then select SRS
Premium Sound.

Front



@0
:

a
.

Component

Description

1) n Audio-out (headphone) jack

Connects optional powered stereo speakers, headphones,
earbuds, a headset, or television audio.

WARNING! To reduce the risk of personal injury, adjust
the volume before putting on headphones, earbuds, or a
headset. For additional safety information, see the
Regulatory, Safety, and Environmental Notices. To access
the user guides, from the Start screen, select the HP
Support Assistant app, select My computer, and then
select User guides.

NOTE: When a device is connected to the jack, the
computer speakers are disabled.

(2) . Audio-in (microphone) jack Connects an optional computer headset microphone,
l.'l'." stereo array microphone, or monaural microphone.
(3) USB 3.0 ports (2) Connect optional USB 3.0 compatible devices and provide

enhanced USB power performance.

NOTE: For details about different types of USB ports, see
Using a USB device on page 51.

External monitor port

“ o

Connects an external VGA monitor or projector.

(5) Smart card reader Supports optional smart cards.

(6) Upgrade bay (optical drive shown) The upgrade bay can hold either a hard drive or an optical
drive that reads and writes (select models only) to an
optical disc. It can also hold a weight saver option.

(7) Optical drive eject button (select models Releases the optical drive disc tray.

only)
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Left

Component

Description

()

Security cable slot

Attaches an optional security cable to the computer.

NOTE: The security cable is designed to act as a
deterrent, but it may not prevent the computer from being
mishandled or stolen.

()

RJ-45 (network) jack

Connects a network cable.

(3) Vents (2) Enable airflow to cool internal components.
NOTE: The computer fan starts up automatically to cool
internal components and prevent overheating. It is normal
for the internal fan to cycle on and off during routine
operation.
(4) +[E DisplayPort Connects an optional digital display device, such as a
+ high-performance monitor or projector.
(5) sSATA eSATA/USB 2.0 combo port Connects an optional high-performance eSATA
= component, such as an eSATA external hard drive, or
connects an optional USB device.
(6) "'% USB 2.0 port Connects an optional USB device.
(7) £ USB charging port Connects an optional USB device. The USB charging port
= can also charge select models of cell phones and MP3
players, even when the computer is off.
(8) Lr_iy 1394 port Connects an optional IEEE 1394 or 1394a device, such as

no

a camcorder.

9

IIlIJ

HP ExpressCard slot

Supports optional ExpressCards.

Left
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Rear

Component Description
(1) K RJ-11 (modem) jack Connects a modem cable.
(2) | E Power connector Connects an AC adapter.
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Component Description

(1) Internal display switch Turns off the display or initiates Sleep if the display is closed
while the power is on.

NOTE: The display switch is not visible from the outside of the
computer.

(2) WLAN antennas (3)* Send and receive wireless signals to communicate with wireless
local area networks (WLAN).

(3) WWAN antennas (2)* Send and receive wireless signals to communicate with wireless
wide area networks (WWAN).

(4) Internal microphones (2) Record sound.
(5) Webcam light (select models only) On: The webcam is in use.
(6) Webcam (select models only) Records video and captures still photographs.

For information on using the webcam, access Help and Support.
From the Start screen, type h, and then select Help and
Support.

*The antennas are not visible from the outside of the computer. For optimal transmission, keep the areas immediately
around the antennas free from obstructions. To see wireless regulatory notices, see the section of the Regulatory, Safety,
and Environmental Notices that applies to your country or region. To access the user guides, from the Start screen, select
the HP Support Assistant app, select My computer, and then select User guides.
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Bottom

Component Description

1) Battery bay Holds the battery.

(2) SIM slot Supports a wireless subscriber identity module (SIM).
m The SIM slot is located inside the battery bay.

(3) D Battery release latch Releases the battery.

(4) Accessory battery connector Connects an optional accessory battery.

(5) Docking connector Connects an optional docking device.

(6) Service door release latch Releases the service door from the computer.

(7) Vents (4) Enable airflow to cool internal components.

NOTE: The computer fan starts up automatically to
cool internal components and prevent overheating. It is
normal for the internal fan to cycle on and off during
routine operation.
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Component

Description

(8)

(%)

Bluetooth compartment

Contains a Bluetooth device (select models only).

9

=

Service door

Provides access to the hard drive, the wireless LAN
(WLAN) module slot, the WWAN module slot, and the
memory module slots.

CAUTION: To prevent an unresponsive system,
replace the wireless module only with a wireless
module authorized for use in the computer by the
governmental agency that regulates wireless devices
in your country or region. If you replace the module
and then receive a warning message, remove the
module to restore computer functionality, and then
contact technical support through Help and Support.
From the Start screen, type h, and then select Help
and Support.

Bottom
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3 Connecting to a network

Your computer can travel with you wherever you go. But even at home, you can explore the globe
and access information from millions of websites using your computer and a wired or wireless
network connection. This chapter will help you get connected to that world.

Connecting to a wireless network

Wireless technology transfers data across radio waves instead of wires. Your computer may be
equipped with one or more of the following wireless devices:

e  Wireless local area network (WLAN) device—Connects the computer to wireless local area
networks (commonly referred to as Wi-Fi networks, wireless LANs, or WLANS) in corporate
offices, your home, and public places such as airports, restaurants, coffee shops, hotels, and
universities. In a WLAN, the mobile wireless device in your computer communicates with a
wireless router or a wireless access point.

e HP Mobile Broadband Module (select models only)—A wireless wide area network (WWAN)
device that gives you wireless connectivity over a much larger area. Mobile network operators
install base stations (similar to cell phone towers) throughout large geographic areas, effectively
providing coverage across entire states, regions, or even countries.

e  Bluetooth device—Creates a personal area network (PAN) to connect to other Bluetooth-
enabled devices such as computers, phones, printers, headsets, speakers, and cameras. In a
PAN, each device communicates directly with other devices, and devices must be relatively
close together—typically within 10 meters (approximately 33 feet) of each other.

For more information about wireless technology, see the information and website links provided in
Help and Support. From the Start screen, type h, and then select Help and Support.

Using the wireless controls

You can control the wireless devices in your computer using these features:

e  Wireless button, wireless switch, or wireless key (referred to in this chapter as the wireless
button)

e  Operating system controls

Using the wireless button

The computer has a wireless button, one or more wireless devices, and one or two wireless lights,
depending on the model. All of the wireless devices on your computer are enabled at the factory, so
the wireless light is on (white) when you turn on the computer.

The wireless light indicates the overall power state of your wireless devices, not the status of
individual devices. If the wireless light is white, at least one wireless device is on. If the wireless light
is off, all wireless devices are off.

E/?’NOTE: On some models, the wireless light is amber when all wireless devices are off.

Because the wireless devices are enabled at the factory, you can use the wireless button to turn on or
turn off the wireless devices simultaneously.
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Using operating system controls

The Network and Sharing Center allows you to set up a connection or network, connect to a network,
manage wireless networks, and diagnose and repair network problems.

To use operating system controls:

1. From the Start screen, type n, and then select Settings.

2. Type network and sharing in the search box, and then select Network and Sharing
Center.

For more information, from the Start screen, type h, and then select Help and Support.

Using a WLAN

With a WLAN device, you can access a wireless local area network (WLAN), which is composed of
other computers and accessories that are linked by a wireless router or a wireless access point.

E’%NOTE: The terms wireless router and wireless access point are often used interchangeably.

e Alarge-scale WLAN, such as a corporate or public WLAN, typically uses wireless access points
that can accommodate a large number of computers and accessories and can separate critical
network functions.

e A home or small office WLAN typically uses a wireless router, which allows several wireless and
wired computers to share an Internet connection, a printer, and files without requiring additional
pieces of hardware or software.

To use the WLAN device in your computer, you must connect to a WLAN infrastructure (provided
through a service provider or a public or corporate network).

Using an Internet service provider

When you are setting up Internet access in your home, you must establish an account with an
Internet service provider (ISP). To purchase Internet service and a modem, contact a local ISP. The
ISP will help set up the modem, install a network cable to connect your wireless computer to the
modem, and test the Internet service.

E’%NOTE: Your ISP will give you a user ID and a password to use for Internet access. Record this
information and store it in a safe place.
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Setting up a WLAN

To set up a WLAN and connect to the Internet, you need the following equipment:

e A broadband modem (either DSL or cable) (1) and high-speed Internet service purchased from
an Internet service provider

e A wireless router (2) (purchased separately)

e A wireless computer (3)

= NOTE: Some modems have a built-in wireless router. Check with your ISP to determine what type
of modem you have.

The illustration below shows an example of a wireless network installation that is connected to the
Internet.

©

As your network grows, additional wireless and wired computers can be connected to the network to
access the Internet.

For help in setting up your WLAN, see the information provided by your router manufacturer or your
ISP.

Configuring a wireless router

For help in setting up a WLAN, see the information provided by your router manufacturer or your ISP.

@NOTE: It is recommended that you initially connect your new wireless computer to the router by
using the network cable provided with the router. When the computer successfully connects to the
Internet, disconnect the cable, and access the Internet through your wireless network.

Protecting your WLAN

When you set up a WLAN or access an existing WLAN, always enable security features to protect
your network from unauthorized access. WLANSs in public areas (hotspots) like coffee shops and
airports may not provide any security. If you are concerned about the security of your computer in a
hotspot, limit your network activities to email that is not confidential and basic Internet surfing.

Wireless radio signals travel outside the network, so other WLAN devices can pick up unprotected
signals. Take the following precautions to protect your WLAN:

° Use a firewall.

A firewall checks both data and requests for data that are sent to your network, and discards any
suspicious items. Firewalls are available in both software and hardware. Some networks use a
combination of both types.

e  Use wireless encryption.

Wireless encryption uses security settings to encrypt and decrypt data that is transmitted over
the network. For more information, from the Start screen, type h, and then select Help and
Support.
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Connecting to a WLAN

To connect to the WLAN, follow these steps:

1. Be sure that the WLAN device is on. If the device is on, the wireless light is on. If the wireless
light is off, press the wireless button.

@’NOTE: On some models, the wireless light is amber when all wireless devices are off.

2. From the Windows desktop, tap and hold, or click the network status icon in the notification area,
at the far right of the taskbar.

3. Select your WLAN from the list.
4. Click Connect.

If the WLAN is a security-enabled WLAN, you are prompted to enter a security code. Type the
code, and then click OK to complete the connection.

@NOTE: If no WLANS are listed, you may be out of range of a wireless router or access point.

=¥ NOTE: If you do not see the WLAN you want to connect to, from the Windows desktop, right-
click the network status icon, and then select Open Network and Sharing Center. Click Set up
a new connection or network. A list of options is displayed, allowing you to manually search
for and connect to a network or to create a new network connection.

After the connection is made, place the mouse pointer over the network status icon in the notification
area, at the far right of the taskbar, to verify the name and status of the connection.

E’%NOTE: The functional range (how far your wireless signals travel) depends on WLAN
implementation, router manufacturer, and interference from other electronic devices or structural
barriers such as walls and floors.

Using HP Mobile Broadband (select models only)

HP Mobile Broadband enables your computer to use WWANSs to access the Internet from more
places and over larger areas than it can by using WLANs. Using HP Mobile Broadband requires a
network service provider (called a mobile network operator), which in most cases is a cellular phone
network operator. Coverage for HP Mobile Broadband is similar to cellular phone voice coverage.

When used with mobile network operator service, HP Mobile Broadband gives you the freedom to
stay connected to the Internet, send email, or connect to your corporate network whether you are on
the road or outside the range of Wi-Fi hotspots.

HP supports the following technologies:

e HSPA (High Speed Packet Access), which provides access to networks based on the Global
System for Mobile Communications (GSM) telecommunications standard.

e EV-DO (Evolution Data Optimized), which provides access to networks based on the code
division multiple access (CDMA) telecommunications standard.

You may need the HP Mobile Broadband Module serial number to activate mobile broadband service.
The serial number is printed on a label inside the battery bay of your computer.

Some mobile network operators require the use of a SIM. A SIM contains basic information about
you, such as a personal identification number (PIN), as well as network information. Some computers
include a SIM that is preinstalled in the battery bay. If the SIM is not preinstalled, it may be provided
in the HP Mobile Broadband information provided with your computer or the mobile network operator
may provide it separately from the computer.
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For information about inserting and removing the SIM, see Inserting and removing a SIM
on page 20.

For information about HP Mobile Broadband and how to activate service with a preferred mobile
network operator, see the HP Mobile Broadband information included with your computer. For
additional information, see the HP website at http://www.hp.com/go/mobilebroadband (select regions/
countries only).

Inserting and removing a SIM

/\ CAUTION: To prevent damage to the connectors, use minimal force when inserting a SIM.

To insert a SIM, follow these steps:

Shut down the computer.

Close the display.

Disconnect all external devices connected to the computer.

Unplug the power cord from the AC outlet.

Turn the computer upside down on a flat surface, with the battery bay toward you.

Remove the battery (see Inserting or removing the battery on page 43).

N o o » w DN =

Insert the SIM into the SIM slot, and gently push the SIM into the slot until it is firmly seated.

@NOTE: See the image on the battery bay to determine which way the SIM card should be
inserted into your computer.

8. Replace the battery.

=¥ NOTE: HP Mobile Broadband will be disabled if the battery is not replaced.

9. Reconnect external power.
10. Reconnect external devices.

11. Turn on the computer.
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To remove a SIM, press in on the SIM, and then remove it from the slot.

Using GPS (select models only)

Your computer may be equipped with a Global Positioning System (GPS) device. GPS satellites
deliver location, speed, and direction information to GPS-equipped systems.

For more information, see the HP GPS and Location software Help.

Using Bluetooth wireless devices

A Bluetooth device provides short-range wireless communications that replace the physical cable
connections that traditionally link electronic devices such as the following:

e Computers (desktop, notebook, PDA)

e  Phones (cellular, cordless, smart phone)
e Imaging devices (printer, camera)

e Audio devices (headset, speakers)

e Mouse

Bluetooth devices provide peer-to-peer capability that allows you to set up a personal area network
(PAN) of Bluetooth devices. For information about configuring and using Bluetooth devices, see the
Bluetooth software Help.

Connecting to a wired network

There are 2 kinds of wired connections: local area network (LAN) and modem connection. A LAN
connection uses a network cable and is much faster than a modem, which uses a telephone cable.
Both cables are sold separately.

AWARNING! To reduce the risk of electric shock, fire, or damage to the equipment, do not plug a
modem cable or telephone cable into an RJ-45 (network) jack.

Connecting to a local area network (LAN)

Use a LAN connection if you want to connect the computer directly to a router in your home (instead
of working wirelessly), or if you want to connect to an existing network at your office.

Connecting to a LAN requires an 8-pin, RJ-45 network cable.
To connect the network cable, follow these steps:

1. Plug the network cable into the network jack (1) on the computer.
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2.  Plug the other end of the network cable into a network wall jack (2) or router.

“»NOTE: If the network cable contains noise suppression circuitry (3), which prevents
interference from TV and radio reception, orient the circuitry end of the cable toward the
computer.

T

o —

Using a modem

A modem must be connected to an analog telephone line using a 6-pin, RJ-11 modem cable. In some
countries or regions, a specific modem cable adapter is also required. Jacks for digital PBX systems
may resemble analog telephone jacks, but they are not compatible with the modem.

Connecting a modem cable
To connect the modem cable, follow these steps:
1. Plug the modem cable into the modem jack (1) on the computer.

2. Plug the modem cable into the RJ-11 telephone wall jack (2).

E%?NOTE: If the modem cable contains noise suppression circuitry (3), which prevents
interference from TV and radio reception, orient the circuitry end of the cable toward the
computer.
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Connecting a country- or region-specific modem cable adapter

Telephone jacks vary by country or region. To use the modem and the modem cable outside the
country or region in which you purchased the computer, you must obtain a country- or region-specific
modem cable adapter.

To connect the modem to an analog telephone line that does not have an RJ-11 telephone jack,
follow these steps:

1. Plug the modem cable into the modem jack (1) on the computer.
2. Plug the modem cable into the modem cable adapter (2).

3. Plug the modem cable adapter (3) into the telephone wall jack.
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4 Navigating using the keyboard, touch
gestures and pointing devices

Your computer allows navigation using touch gestures (select models only) in addition to the
keyboard and mouse. Touch gestures can be used on your computer TouchPad or on a touch screen
(select models only).

Review the Windows 8 Basics guide included with your computer. The guide provides information on
common tasks using the TouchPad, touch screen, or the keyboard.

Select computer models have special action keys or hot key functions on the keyboard to perform
routine tasks.

Using pointing devices

@NOTE: In addition to the pointing devices included with your computer, you can use an external
USB mouse (purchased separately) by connecting it to one of the USB ports on the computer.

Setting pointing device preferences

Use Mouse Properties in Windows to customize settings for pointing devices, such as button
configuration, click speed, and pointer options.

To access Mouse Properties:

e From the Start screen, type mouse, click Settings, and then select Mouse.

Using the pointing stick

Press the pointing stick in the direction you want to move the pointer on the screen. Use the left and
right pointing stick buttons as you would the left and right buttons on an external mouse.

Using the TouchPad

To move the pointer, slide one finger across the TouchPad in the direction you want the pointer to go.
Use the left and right TouchPad buttons like the buttons on an external mouse.
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Turning the TouchPad off and on
To turn the TouchPad off and on, quickly double-tap the TouchPad on/off button.

2X 3%
K>

Using TouchPad gestures

Your TouchPad or touch screen (select models only) allows you to navigate the pointing device on
the screen by using your fingers to control the pointer action.

*O-TIP: For touch screen computers, you may perform the gestures on the display, on the TouchPad or
"*" a combination of the two.

The TouchPad supports a variety of gestures. To use TouchPad gestures, place two fingers on the
TouchPad at the same time.

E/%?NOTE: TouchPad gestures are not supported in all programs.

1. From the Start screen, type mouse, click Settings, and then select Mouse from the list of
applications.

2. Click the Device Settings tab, select the device in the window that is displayed, and then click
Settings.

3. Click a gesture to activate the demonstration.
To turn the gestures off or on:

1. From the Start screen, type mouse, click Settings, and then select Mouse from the list of
applications.

2. Click the Device Settings tab, select the device in the window that is displayed, and then click
Settings.

3. Select the check box next to the gesture that you want to turn off or on.

4. Click Apply, and then click OK.

Using pointing devices
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Tapping
To make an on-screen selection, use the tap function on the TouchPad.

e Point to an item on the screen, and then tap one finger on the TouchPad zone to make a
selection. Double-tap an item to open it.

Scrolling
Scrolling is useful for moving up, down, or sideways on a page or image.

e Place two fingers slightly apart on the TouchPad zone and then drag them up, down, left, or
right.
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Pinching/zooming
Pinching and zooming allow you to zoom out or in on images or text.

e Zoom in by placing two fingers together on the TouchPad zone and then moving your fingers
apart.

e  Zoom out by placing two fingers apart on the TouchPad zone and then moving your fingers

together.

Rotating (select models only)
Rotating allows you to turn items such as photos.

e Point to an object, and then anchor the forefinger of your left hand in the TouchPad zone. Using
your right hand, slide your forefinger in a sweeping motion from 12 o’clock to 3 o’clock. To
reverse the rotation, move your forefinger from 3 o’clock to 12 o’clock.

E’%NOTE: Rotating is intended for specific apps where you can manipulate an object or image. It may
not be functional for all apps.

2-finger click (select models only)
2-finger click allows you to make menu selections for an object on the screen.

e Place two fingers on the TouchPad zone and press to open the options menu for the selected
object.
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Flicking (select models only)
Flicking allows you to navigate through screens or quickly scroll through documents.

e Place three fingers on the TouchPad zone and flick your fingers in a light, quick motion up,
down, left or right.

Edge swipes (select models only)

Edge swipes allow you to access toolbars on your computer for tasks such as changing settings and
finding or using apps.

Right-edge swipe

The right-edge swipe reveals the charms, which let you search, share, start apps, access devices, or
change settings.

e  Swipe your finger gently from the right edge to display the charms.
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Top-edge swipe

The top-edge swipe allows you to open apps available from the Start screen.

E'%IMPORTANT: When an app is active, the top-edge gesture varies depending on the app.

e  Swipe your finger gently from the top edge to display available apps.

Left-edge swipe

The left-edge swipe accesses your recently opened apps so that you can switch between them
quickly.

e  Swipe your finger gently from the left edge of the TouchPad to switch between recently opened
apps.
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Using the keyboard

The keyboard and mouse allow you to type select items, scroll and to perform the same functions as
using touch gestures. The keyboard also allows you to use action keys and hot keys to perform
specific functions.

'i?‘ TIP: The Windows logo key == on the keyboard allows you to quickly return to the Start screen

from an open app or the Windows desktop. Pressing the Windows logo key again will return you to
the previous screen.

= NOTE: Depending on the country or region, your keyboard may have different keys and keyboard
functions than those discussed in this section.

Using Microsoft Windows 8 shortcut keys
Microsoft Windows 8 provides shortcuts to perform actions quickly. Several shortcuts will help you
with Windows 8 functions. Press the Windows logo key == in combination with the key to perform
the action.

For additional information on Windows 8 shortcut keys go to Help and Support. From the Start
screen, type h, and then select Help and Support.

Shortcut Key Description

key
an Returns you to the Start screen from an open app or the Windows
L1 | desktop. Pressing the key again returns you to the previous screen.
_ + c Opens the charms.
Ll |
an + d Opens the Windows desktop.
Ll |
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Shortcut Key Description

key
an + tab Switches between open apps.
- NOTE: Continue to press this key combination until the app you
want opens.
alt + f4 Closes an active app.

Identifying the hot keys

A hot key is a combination of the fn key (1) and either the esc key (2), or one of the function keys (3).

To use a hot key:

A Briefly press the fn key, and then briefly press the second key of the hot key combination.

Hot key combination Description

fn+esc Displays system information.

fn+f3 Initiates Sleep, which saves your information in system memory. The display and other system
t’ components turn off and power is conserved.

To exit Sleep, briefly press the power button.
CAUTION: To reduce the risk of information loss, save your work before initiating Sleep.

NOTE: If a critical battery level occurs while the computer is in the Sleep state, the computer
initiates Hibernation and the information stored in system memory is saved to the hard drive.

The function of the fn+f3 hot key can be changed. For example, you can set the fn+f3 hot key
to initiate Hibernation instead of Sleep. In all Windows operating system windows, references
to the Sleep button apply to the fn+f3 hot key.

fn+f4 Switches the screen image among display devices connected to the system. For example, if a
ED' monitor is connected to the computer, fn+f4 alternates the screen image from computer
display to monitor display to simultaneous display on both the computer and the monitor.

Most external monitors receive video information from the computer using the external VGA
video standard. The fn+f4 hot key can also alternate images among other devices that are
receiving video information from the computer.
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Hot key combination Description

‘ fn+f6 Decreases speaker volume.
)
‘ﬂ} fn+f7 Increases speaker volume.
fn+f8 Displays battery charging level.

& fn+f9 Decreases the screen brightness level.
X fn+f10 Increases the screen brightness level.

i

| fn+f12 Turns the keyboard backlight on and off (select models only).
&
“EEE

NOTE: The keyboard backlight is turned on at the factory. To extend battery life, turn off the
keyboard backlight.

Using keypads

The computer includes an integrated numeric keypad. The computer also supports an optional
external numeric keypad, or an optional external keyboard that includes a numeric keypad.
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Using the integrated numeric keypad

Component Description

(1) num |k key Alternates between the navigational and numeric functions on the
integrated numeric keypad.

NOTE: The keypad function that is active when the computer is
turned off is reinstated when the computer is turned back on.

(2) Integrated numeric keypad When num |k has been enabled, it can be used like an external
numeric keypad.

(3) Num lock light e  On: The keypad function is numeric.

e  Off: The keypad function is navigational.

Using an optional external numeric keypad

Keys on most external numeric keypads function differently according to whether num lock is on or
off. (Num lock is turned off at the factory.) For example:

e  When num lock is on, most keypad keys type numbers.
e  When num lock is off, most keypad keys function like the arrow, page up, or page down keys.

When num lock on an external keypad is turned on, the num lock light on the computer is turned on.
When num lock on an external keypad is turned off, the num lock light on the computer is turned off.

To turn num lock on or off on an external keypad as you work:

A Press the num Ik key on the external keypad, not on the computer.
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Multimedia

Your computer may include the following:
e Integrated speaker(s)

e Integrated microphone(s)

e Integrated webcam

e  Preinstalled multimedia software

e  Multimedia buttons or keys

Using the media activity controls

Depending on your computer model, you may have the following media activity controls that allow
you to play, pause, fast forward, or rewind a media file:

Media buttons
e Media hot keys (specific keys pressed in combination with the fn key)

e Media keys

Audio

On your HP computer, you can play music CDs, download and listen to music, stream audio content
from the web (including radio), record audio, or mix audio and video to create multimedia. To
enhance your listening enjoyment, attach external audio devices such as speakers or headphones.

Connecting speakers

You can attach wired speakers to your computer by connecting them to a USB port (or the audio-out
jack) on your computer or on a docking station.

To connect wireless speakers to your computer, follow the device manufacturer's instructions. Before
connecting audio devices, be sure to adjust the volume.

Adjusting the volume

34

Depending on your computer model, you can adjust the volume using the following:
e  Volume buttons
e Volume hot keys (specific keys pressed in combination with the fn key)

e  Volume keys

/\ WARNING! To reduce the risk of personal injury, adjust the volume before putting on headphones,
earbuds, or a headset. For additional safety information, see the Regulatory, Safety and
Environmental Notices. To access the user guides, from the Start screen, select the HP Support
Assistant app, select My computer, and then select User guides.

@NOTE: Volume can also be controlled through the operating system and some programs.
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E‘%NOTE: Refer to the Getting to know your computer on page 4 section for information on what type
of volume controls your computer has.

Connecting headphones

You can connect wired headphones to the headphone jack on your computer.

To connect wireless headphones to your computer, follow the device manufacturer's instructions.

AWARNING! To reduce the risk of personal injury, lower the volume setting before putting on
headphones, earbuds, or a headset. For additional safety information, see the Regulatory, Safety and
Environmental Notices.

Connecting a microphone
To record audio, connect a microphone to the microphone jack on the computer. For best results

when recording, speak directly into the microphone and record sound in a setting free of background
noise.

Checking audio functions on the computer

E‘%NOTE: For best results when recording, speak directly into the microphone and record sound in a
setting free of background noise.

To check the audio functions on your computer, follow these steps:
1. From the Start screen, type c, and then select Control Panel from the list of applications.
2. Select Hardware and Sound, and then select Sound.

When the Sound window opens, select the Sounds tab. Under Program Events, select any
sound event, such as a beep or alarm, and then click Test.

To check the recording functions on your computer, follow these steps:

1. From the Start screen, type s, and then select Sound Recorder.

2. Click Start Recording and speak into the microphone. Save the file to your Windows desktop.
3. Open a multimedia program and play back the recording.

To confirm or change the audio settings on your computer:

1. From the Start screen, type c, and then select Control Panel from the list of applications.

2. Select Hardware and Sound, and then select Sound.

Webcam (select models only)

Some computers include an integrated webcam. With the preinstalled software, you can use the
webcam to take a photo or record a video. You can preview and save the photo or video recording.

The webcam software enables you to experiment with the following features:
e  Capturing and sharing video
e  Streaming video with instant message software

e  Taking still photos
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Administrators can set the security level for Face Recognition in the Security Manager Setup Wizard
or HP ProtectTools Administrative Console. For more information, see the Face Recognition software
Help. To access the user guides, from the Start screen, select the HP Support Assistant app, select

My computer, and then select User guides. For details about using the webcam, refer to the help for
the app.

Video

Your HP computer is a powerful video device that enables you to watch streaming video from your
favorite websites and download video and movies to watch on your computer without needing to
connect to a network.

To enhance your viewing enjoyment, use one of the video ports on the computer to connect an
external monitor, projector, or TV.

Your computer has one or more of the following external video ports:

e VGA

e  HDMI (High Definition Multimedia Interface)
e DisplayPort

@IMPORTANT: Be sure that the external device is connected to the correct port on the computer,
using the correct cable. Check the device manufacturer's instructions if you have questions.

@NOTE: Refer to the Getting to know your computer on page 4 section for information about your
computer's video ports.

VGA

The external monitor port, or VGA port, is an analog display interface that connects an external VGA
display device such as an external VGA monitor or a VGA projector to the computer.
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To connect a VGA display device to the external monitor port:

1. Connect the VGA cable from the monitor or projector to the VGA port on the computer as
shown.

|mm]

2. Press fn+f4 to alternate the screen image between 4 display states:
e PC Screen only: View the screen image on the computer only.

e Duplicate: View the screen image simultaneously on both the computer and external
device.

e Extend: View the screen image extended across both the computer and external device.
e Second screen only: View the screen image on the external device only.

Each time you press fn+f4, the display state changes.

E‘%NOTE: Adjust the screen resolution of the external device, especially if you choose the “Extend”
option. From the Start screen, type ¢, and then select Control Panel from the list of apps. Select
Appearance and Personalization. Under Display, select Adjust screen resolution for best results.

DisplayPort (select models only)

The DisplayPort connects the computer to an optional video or audio device, such as a high-definition
television, or to any compatible digital or audio component. The DisplayPort delivers higher
performance than the VGA external monitor port and improves digital connectivity.

%‘%NOTE: To transmit video and/or audio signals through the DisplayPort, you need a DisplayPort
cable (purchased separately).

E%NOTE: One DisplayPort device can be connected to the DisplayPort port on the computer. The
information displayed on the computer screen can be simultaneously displayed on the DisplayPort
device.
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To connect a video or audio device to the DisplayPort:

1. Connect one end of the DisplayPort cable to the DisplayPort port on the computer.

2. Connect the other end of the cable to the video device.
3. Press fn+f4 to alternate the computer screen image between 4 display states:
e PC screen only: View the screen image on the computer only.

e Duplicate: View the screen image simultaneously on both the computer and external
device.

e Extend: View the screen image extended across both the computer and external device.
e  Second screen only: View the screen image on the external device only.

Each time you press fn+f4, the display state changes.

= NOTE: Adjust the screen resolution of the external device, especially if you choose the “Extend”
option. From the Start screen, type ¢, and then select Control Panel from the list of applications.
Select Appearance and Personalization. Under Display, select Adjust screen resolution for best
results.

@NOTE: To remove the device cable, press down on the connector release button to disconnect it on
the computer.
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6 Power management

“»NOTE: A computer may have a power button or a power switch. The term power button is used
throughout this guide to see both types of power controls.

Shutting down the computer

/\ CAUTION: Unsaved information is lost when the computer shuts down.

The shutdown command closes all open programs, including the operating system, and then turns off
the display and computer.

Shut down the computer under any of the following conditions:
e When you need to replace the battery or access components inside the computer

e  When you are connecting an external hardware device that does not connect to a Universal
Serial Bus (USB) port

e  When the computer will be unused and disconnected from external power for an extended
period

Although you can turn off the computer with the power button, the recommended procedure is to use
the Windows shutdown command:

E”%NOTE: If the computer is in the Sleep state or in Hibernation, you must first exit Sleep or
Hibernation before shutdown is possible by briefly pressing the power button.

1. Save your work and close all open programs.
2. From the Start screen, point to the upper-right or lower-right corner of the screen.
3. Click Settings, click the Power icon, and then click Shut down.

If the computer is unresponsive and you are unable to use the preceding shutdown procedure, try the
following emergency procedures in the sequence provided:

e  Press cirl+alt+delete. Click the Power icon, and then click Shut Down.
e Press and hold the power button for at least 5 seconds.
e Disconnect the computer from external power.

e On models with a user-replaceable battery, remove the battery.

Setting power options

Using power-saving states

Sleep is enabled at the factory.

When Sleep is initiated, the power lights blink and the screen clears. Your work is saved to memory.

A CAUTION: To reduce the risk of possible audio and video degradation, loss of audio or video
playback functionality, or loss of information, do not initiate Sleep while reading from or writing to a
disc or an external media card.
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E/?’NOTE: You cannot initiate any type of networking connection or perform any computer functions
while the computer is in the Sleep state.

Intel Rapid Start Technology (select models only)

For select models, the Intel Rapid Start Technology (RST) feature is enabled by default. Rapid Start
Technology allows your computer to resume quickly from inactivity.

Rapid Start Technology manages your power-saving options as follows:

e Sleep—Rapid Start Technology allows you to select the Sleep state. To exit from Sleep, press
any key, activate the TouchPad, or press the power button briefly.

e Hibernation—Rapid Start Technology initiates Hibernation after a period of inactivity while in the
Sleep state when running on battery power or on external power or when the battery reaches a
critical level. After Hibernation is initiated, press the power button to resume your work.

=¥ NOTE: Rapid Start Technology can be disabled in Setup Utility (BIOS). If you want to be able to
initiate the Hibernation state, you must enable user-initiated Hibernation using Power Options. See
Enabling and exiting user-initiated Hibernation on page 40.

Initiating and exiting Sleep
With the computer on, you can initiate Sleep in any of the following ways:
e  Briefly press the power button.

e From the Start screen, point to the upper-right or lower-right corner of the screen. When the
charms list opens, click Settings, click the Power icon, and then click Sleep.

To exit Sleep, briefly press the power button.

When the computer exits Sleep, the power lights turn on and the computer returns to the screen
where you stopped working.

=¥ NOTE: If you have set a password to be required on wakeup, you must enter your Windows
password before the computer will return to the screen.

Enabling and exiting user-initiated Hibernation

You can enable user-initiated Hibernation and change other power settings and timeouts using Power
Options:

1. From the Start screen, type power, select Settings, and then select Power Options.
2. Inthe left pane, click Choose what the power button does.

3. Click Change Settings that are currently unavailable.

4. Inthe When | press the power button area, select Hibernate.

5. Click Save changes.

To exit Hibernation, briefly press the power button. The power lights turn on and your work returns to
the screen where you stopped working.

=¥ NOTE: If you have set a password to be required on wakeup, you must enter your Windows
password before your work will return to the screen.
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Setting password protection on wakeup

To set the computer to prompt for a password when the computer exits Sleep or Hibernation, follow
these steps:

1. From the Start screen, type power, select Settings, and then select Power Options.
2. Inthe left pane, click Require a password on wakeup.
3. Click Change Settings that are currently unavailable.

4. Click Require a password (recommended).

@NOTE: If you need to create a user account password or change your current user account
password, click Create or change your user account password, and then follow the on-
screen instructions. If you do not need to create or change a user account password, go to step
5.

5. Click Save changes.

Using the power meter and power settings

The power meter is located on the Windows desktop. The power meter allows you to quickly access
power settings and view the remaining battery charge.

e To display the percentage of remaining battery charge and the current power plan, on the
Windows desktop, point over the power meter icon.

e To use Power Options, or to change the power plan, click the power meter icon and select an
item from the list. From the Start screen, you can also type power, select Settings, and then
select Power Options.

Different power meter icons indicate whether the computer is running on battery or external power.
The icon also displays a message if the battery has reached a low or critical battery level.

Using battery power

/\ WARNING! To reduce potential safety issues, use only the battery provided with the computer, a
replacement battery provided by HP, or a compatible battery purchased from HP.

The computer runs on battery power whenever it is not plugged into external AC power. Computer
battery life varies, depending on power management settings, running programs, display brightness,
external devices connected to the computer, and other factors. Keeping the battery in the computer
whenever the computer is plugged into AC power charges the battery and also protects your work in
case of a power outage. If the computer contains a charged battery and is running on external AC
power, the computer automatically switches to battery power if the AC adapter is disconnected on the
computer or an AC power loss occurs.

E/?NOTE: When you disconnect AC power, the display brightness is automatically decreased to save
battery life.
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Finding additional battery information

HP Support Assistant provides the tools and information about the battery. To access battery
information, from the Start screen, select the HP Support Assistant app, and then select Battery
and performance.

e  Battery Check tool to test battery performance

e Information on calibration, power management, and proper care and storage to maximize battery
life

e Information on battery types, specifications, life cycles, and capacity
To access battery information:

A To access battery information, from the Start screen, select the HP Support Assistant app, and
then select Battery and performance.

Using Battery Check
Help and Support provides information on the status of the battery installed in the computer.
To run Battery Check:

1. Connect the AC adapter to the computer.

E’%NOTE: The computer must be connected to external power for Battery Check to work properly.

2. To access battery information, from the Start screen, select the HP Support Assistant app, and
then select Battery and performance.

Battery Check examines the battery and its cells to see if they are functioning properly, and then
reports the results of the examination.

Displaying the remaining battery charge

A Move the pointer over the power meter icon on the Windows desktop in the notification area, at
the far right of the taskbar.

Maximizing battery discharge time

Battery discharge time varies depending on features you use while on battery power. Maximum
discharge time gradually decreases as the battery storage capacity naturally degrades.

Tips for maximizing battery discharge time:
e Lower the brightness on the display.

e Remove the battery on the computer when it is not being used or charged, if the computer
contains a user-replaceable battery

e  Store the user-replaceable battery in a cool, dry location.

e  Select the Power saver setting in Power Options.

Managing low battery levels

The information in this section describes the alerts and system responses set at the factory. Some
low-battery alerts and system responses can be changed using Power Options. Preferences set
using Power Options do not affect lights.

From the Start screen, type power, select Settings, and then select Power Options.
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Identifying low battery levels

When a battery that is the sole power source for the computer reaches a low or critical battery level,
the following behavior occurs:

e  The battery light (select models only) indicates a low or critical battery level.

e  The power meter icon in the notification area, at the far right of the taskbar, shows a low or
critical battery notification.

2»NOTE: For additional information about the power meter, see Using the power meter and
power settings on page 41.

If the computer is on or in the Sleep state, the computer remains briefly in the Sleep state, and then
shuts down and loses any unsaved information.

Resolving a low battery level

Resolving a low battery level when external power is available
A Connect one of the following devices:
e AC adapter
e  Optional docking or expansion device

e  Optional power adapter purchased as an accessory from HP

Resolving a low battery level when no power source is available

To resolve a low battery level when no power source is available, save your work and shut down the
computer.

Inserting or removing the battery
To insert the battery:

1. Insert the battery into the battery bay, aligning the tabs on the battery (1) with the notches on the
computer.

2. Press the battery (2) down until it is seated. The battery automatically locks into place.

To remove the battery:
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/\ CAUTION: Removing a battery that is the sole power source for the computer can cause loss of
information. To prevent loss of information, save your work and initiate Hibernation or shut down the
computer through Windows before removing the battery.

A Slide the battery release latch (1), and then pull the battery (2) upward. Remove the battery (3).

Conserving battery power
e From the Start screen, type power, select Settings, and then select Power Options.
e  Select low power-use settings through Power Options.

e  Turn off wireless and LAN connections and exit modem applications when you are not using
them.

e Disconnect unused external devices that are not plugged into an external power source.
e  Stop, disable, or remove any external media cards that you are not using.
e Decrease screen brightness.

e  Before you leave your work, initiate Sleep, or shut down the computer.

Storing a user-replaceable battery (select models only)

/\ CAUTION: To reduce the risk of damage to a battery, do not expose it to high temperatures for
extended periods of time.

If a computer will be unused and unplugged from external power for more than 2 weeks, remove the
user-replaceable battery and store it separately.

To prolong the charge of a stored battery, place it in a cool, dry place.

%’NOTE: A stored battery should be checked every 6 months. If the capacity is less than 50 percent,
recharge the battery before returning it to storage.

Calibrate a battery before using it if it has been stored for one month or more.

Disposing of a user-replaceable battery (select models only)

AWARNING! To reduce the risk of fire or burns, do not disassemble, crush, or puncture; do not short
external contacts; do not dispose of in fire or water.
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See the Regulatory, Safety and Environmental Notices for proper battery disposal. To access the
user guides, from the Start screen, select the HP Support Assistant app, select My computer, and
then select User guides. To access battery information, from the Start screen, select the HP
Support Assistant app, and then select Battery and performance.

Replacing a user-replaceable battery (select models only)

Battery Check notifies you to replace the battery when an internal cell is not charging properly or
when the battery storage capacity has reached a weak condition. If the battery is possibly covered by
an HP warranty, instructions include a warranty ID. A message refers you to the HP website for more
information about ordering a replacement battery.

Using external AC power

/\ WARNING! Do not charge the computer battery while you are onboard aircraft.

AWARNING! To reduce potential safety issues, use only the AC adapter provided with the computer,
a replacement AC adapter provided by HP, or a compatible AC adapter purchased from HP.

E%?NOTE: For information on connecting to AC power, see the Setup Instructions poster provided in
the computer box.

External AC power is supplied through an approved AC adapter or an optional docking or expansion
device.

Connect the computer to external AC power under any of the following conditions:
e  When charging or calibrating a battery

e  When installing or modifying system software

e  When writing information to a CD, a DVD, or a BD (select models only)

e  When running Disk Defragmenter

e  When performing a backup or recovery

When you connect the computer to external AC power, the following events occur:
e The battery begins to charge.

e If the computer is turned on, the power meter icon in the notification area, at the far right of the
taskbar, changes appearance.

When you disconnect external AC power, the following events occur:
e  The computer switches to battery power.

e The display brightness is automatically decreased to save battery life.
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Testing an AC adapter

Test the AC adapter if the computer exhibits any of the following symptoms when it is connected to
AC power:

e  The computer does not turn on.
e The display does not turn on.
e  The power lights are off.

To test the AC adapter:

@NOTE: The following instructions apply to computers with user-replaceable batteries.

1. Shut down the computer.
2. Remove the battery from the computer.
3. Connect the AC adapter to the computer, and then plug it into an AC outlet.
4. Turn on the computer.
e If the power lights turn on, the AC adapter is working properly.
e If the power lights remain off, the AC adapter is not functioning and should be replaced.

Contact support for information on obtaining a replacement AC power adapter.
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7 External cards and devices

Using Media Card Reader cards (select models only)

Optional digital cards provide secure data storage and convenient data sharing. These cards are
often used with digital media—equipped cameras and PDAs as well as with other computers.

To determine the digital card formats that are supported on your computer, see Getting to know your
computer on page 4.

Inserting a digital card

/\ CAUTION: To reduce the risk of damage to the digital card connectors, use minimal force to insert
a digital card.

1. Hold the card label-side up, with the connectors facing the computer.

2. Insert the card into the Media Card Reader, and then press in on the card until it is firmly seated.

You will hear a sound when the device has been detected, and a menu of options may be
displayed.

Removing a digital card

/\ CAUTION: To reduce the risk of loss of data or an unresponsive system, use the following
procedure to safely remove the digital card.

1. Save your information and close all programs associated with the digital card.

2. Click the remove hardware icon on the Windows desktop in the notification area, at the far right
of the taskbar. Then follow the on-screen instructions.

Using Media Card Reader cards (select models only)
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3. Pressin on the card (1), and then remove it from the slot (2).

0,
>
(2]

E‘%NOTE: If the card does not eject, pull the card out of the slot.

Using ExpressCards (select models only)

An ExpressCard is a high-performance PC Card that is inserted into the ExpressCard slot.
ExpressCards are designed to conform to the standard specifications of the Personal Computer
Memory Card International Association (PCMCIA).

Configuring an ExpressCard

Install only the software required for the card. If you are instructed by the ExpressCard manufacturer
to install device drivers:

e Install only the device drivers for your operating system.

e Do not install additional software, such as card services, socket services, or enablers, that are
supplied by the ExpressCard manufacturer.
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Inserting an ExpressCard

/\ CAUTION: To prevent damage to the computer and external media cards, do not insert a PC Card
into an ExpressCard slot.

CAUTION: To reduce the risk of damage to the connectors:
Use minimal force when inserting an ExpressCard.
Do not move or transport the computer when an ExpressCard is in use.

E’%NOTE: The following illustration may look slightly different than your device.

The ExpressCard slot may contain a protective insert. To remove the insert:
1.  Pressin on the insert (1) to unlock it.

2. Pull the insert out of the slot (2).

To insert an ExpressCard:
1. Hold the card label-side up, with the connectors facing the computer.

2. Insert the card into the ExpressCard slot, and then press in on the card until it is firmly seated.

|

You will hear a sound when the card has been detected, and a menu of options may be
displayed.

E/?’NOTE: The first time you connect an ExpressCard, a message in the notification area, at the
far right of the taskbar, lets you know that the card is recognized by the computer.

%‘%NOTE: To conserve power, stop or remove an ExpressCard when it is not in use.
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Removing an ExpressCard

/\ CAUTION: To reduce the risk of loss of data or an unresponsive system, use the following
procedure to safely remove the ExpressCard.

1. Save your information and close all programs associated with the ExpressCard.

2. Click the remove hardware icon on the Windows desktop in the notification area, at the far right
of the taskbar, and then follow the on-screen instructions.

3. Release and remove the ExpressCard:
a. Gently press in on the ExpressCard (1) to unlock it.

b. Pull the ExpressCard out of the slot (2).

Using smart cards (select models only)

@NOTE: The term smart card is used throughout this chapter to see both smart cards and Java™
Cards.

A smart card is a credit card-sized accessory that carries a microchip containing memory and a
microprocessor. Like personal computers, smart cards have an operating system to manage input
and output, and they include security features to protect against tampering. Industry-standard smart
cards are used with the smart card reader (select models only).

A PIN is needed to gain access to the contents of the microchip. For more information about smart
card security features, see Help and Support. From the Start screen, type h, and then select Help
and Support.
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Inserting a smart card

1. Hold the card label-side up, and gently slide the card into the smart card reader until the card is

seated.

2. Follow the on-screen instructions for logging on to the computer using the smart card PIN.

Removing a smart card

A Grasp the edge of the smart card, and then pull it out of the smart card reader.

Using a USB device

Universal Serial Bus (USB) is a hardware interface that can be used to connect an optional external
device, such as a USB keyboard, mouse, drive, printer, scanner, or hub.

Some USB devices may require additional support software, which is usually included with the
device. For more information about device-specific software, see the manufacturer's instructions.
These instructions may be provided with the software, on disc, or on the manufacturer’s website.

The computer has at least 1 USB port that supports USB 1.0, 1.1, 2.0, or 3.0 devices. Your computer
may also have a USB charging port that provides power to an external device. An optional docking
device or USB hub provides additional USB ports that can be used with the computer.

Using a USB device
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Connecting a USB device

/\ CAUTION: To reduce the risk of damage to a USB connector, use minimal force to connect the
device.

A Connect the USB cable for the device to the USB port.

E‘%NOTE: The following illustration may look slightly different than your computer.

b

You will hear a sound when the device has been detected.

@NOTE: The first time you connect a USB device, a message in the notification area, at the far right
of the taskbar, lets you know that the device is recognized by the computer.

Removing a USB device

/\ CAUTION: To reduce the risk of damage to a USB connector, do not pull on the cable to remove
the USB device.

CAUTION: To reduce the risk of loss of information or an unresponsive system, use the following
procedure to safely remove the USB device.

1.  Toremove a USB device, save your information and close all programs associated with the
device.

2. Click the remove hardware icon on the Windows desktop in the notification area, at the far right
of the taskbar, and then follow the on-screen instructions.

3. Remove the device.

Using 1394 devices (select models only)

IEEE 1394 is a hardware interface that connects a high-speed multimedia or data storage device to
the computer. Scanners, digital cameras, and digital camcorders often require a 1394 connection.

Some 1394 devices may require additional support software, which is usually included with the
device. For more information about device-specific software, see the manufacturer's instructions.

The 1394 port also supports IEEE 1394a devices.

52 Chapter 7 External cards and devices



Connecting a 1394 device

/\ CAUTION: To reduce the risk of damage to a 1394 port connector, use minimal force to connect the
device.

A To connect a 1394 device to the computer, connect the 1394 cable for the device to the 1394
port.

#ﬂi

R
>

You will hear a sound when the device has been detected.

Removing a 1394 device

/\ CAUTION: To reduce the risk of loss of information or an unresponsive system, stop the 1394
device before removing it.

CAUTION: To reduce the risk of damage to a 1394 connector, do not pull on the cable to remove
the 1394 device.

1. Toremove a 1394 device, save your information and close all programs associated with the
device.

2. Click the remove hardware icon on the Windows desktop in the notification area, at the far right
of the taskbar, and then follow the on-screen instructions.

3. Remove the device.

Using an eSATA device (select models only)

An eSATA port connects an optional high-performance eSATA component, such as an eSATA
external hard drive.

Some eSATA devices may require additional support software, which is usually included with the
device. For more information about device-specific software, see the manufacturer's instructions.

E/i"NOTE: The eSATA port also supports an optional USB device.
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Connecting an eSATA device

A CAUTION: To reduce the risk of damage to an eSATA port connector, use minimal force to connect
the device.

A To connect an eSATA device to the computer, connect the eSATA cable for the device to the
eSATA port.

eSATA
-

You will hear a sound when the device has been detected.

Removing an eSATA device

/\ CAUTION: To reduce the risk of damage to an eSATA connector, do not pull on the cable to
remove the eSATA device.

CAUTION: To reduce the risk of loss of information or an unresponsive system, use the following
procedure to safely remove the device.

1.  Toremove an eSATA device, save your information and close all programs associated with the
device.

2. Click the remove hardware icon on the Windows desktop in the notification area, at the far right
of the taskbar, and then follow the on-screen instructions.

3. Remove the device.

Using optional external devices

= NOTE: For more information about required software and drivers, or to learn which computer port to
use, see the manufacturer's instructions.

To connect an external device to the computer:

ACAUTION: To reduce the risk of damage to the equipment when connecting a powered device, be
sure that the device is turned off and the AC power cord is unplugged.

1. Connect the device to the computer.
2. If you are connecting a powered device, plug the device power cord into a grounded AC outlet.

3.  Turn off the device.
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To disconnect an unpowered external device, turn off the device, and then disconnect it on the
computer. To disconnect a powered external device, turn off the device, disconnect it on the
computer, and then unplug the AC power cord.

Using optional external drives

Removable external drives expand your options for storing and accessing information. A USB drive
can be added by connecting the drive to a USB port to the computer.

E’/f’NOTE: HP external USB optical drives should be connected to the powered USB port to the
computer.

USB drives include the following types:

e 1.44-megabyte diskette drive

e  Hard drive module

e  External optical drive (CD, DVD, and Blu-ray)
e  MultiBay device

Using the docking connector (select models only)

The docking connector connects the computer to an optional docking device. An optional docking
device provides additional ports and connectors that can be used with the computer.

r__*:"/%"NOTE: The following image may look slightly different than your computer or docking device.
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Handling drives

ACAUTION: Drives are fragile computer components that must be handled with care. Refer to the
following cautions before handling drives. Additional cautions are included with the procedures to
which they apply.

Observe these precautions:

e Before you move a computer that is connected to an external hard drive, initiate Sleep and allow
the screen to clear, or properly disconnect the external hard drive.

e Before handling a drive, discharge static electricity by touching the unpainted metal surface of
the drive.

e Do not touch the connector pins on a removable drive or on the computer.
e Handle a drive carefully; do not drop a drive or place items on it.

e  Before removing or inserting a drive, shut down the computer. If you are unsure whether the
computer is off or in the Sleep state, turn the computer on, and then shut it down through the
operating system.

e Do not use excessive force when inserting a drive into a drive bay.

e Do not type on the keyboard or move the computer while an optical drive is writing to a disc. The
write process is sensitive to vibration.

e  When the battery is the only source of power, be sure that the battery is sufficiently charged
before writing to media.

e Avoid exposing a drive to temperature or humidity extremes.
e Avoid exposing a drive to liquids. Do not spray the drive with cleaning products.

e Remove media from a drive before removing the drive from the drive bay, or traveling with,
shipping, or storing a drive.

e If a drive must be mailed, place the drive in a bubble-pack mailer or other suitable protective
packaging and label the package “FRAGILE.”

e Avoid exposing a drive to magnetic fields. Security devices with magnetic fields include airport
walk-through devices and security wands. Airport conveyer belts and similar security devices
that check carry-on baggage use X-rays instead of magnetism and do not damage drives.
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ACAUTION: To prevent information loss or an unresponsive system:

Save your work and shut down the computer before adding or replacing a memory module or hard
drive.

If you are not sure whether the computer is off, turn the computer on by pressing the power button.
Then shut down the computer through the operating system.
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Intel Smart Response Technology (select models only)

Intel® Smart Response Technology (SRT) is an Intel® Rapid Storage Technology (RST) caching
feature that significantly enhances computer system performance. SRT allows computers with an
SSD mSATA module to be used as cache memory between the system memory and hard disk drive.
This provides the advantage of having a hard disk drive (or a RAID volume) for maximum storage
capacity while simultaneously delivering SSD enhanced system performance experience.

If you add or upgrade a hard drive and intend to set a RAID volume, you must temporarily disable
SRT, set the RAID volume, and then enable SRT. To temporarily disable SRT:

1. From the Start screen, type Intel, and then select Intel Rapid Storage Technology.
2. Click the Acceleration link, and then click the Disable Acceleration link.
3.  Wait for the Acceleration Mode to complete.

4. Click the Reset to Available link.

E’/ﬁIMPORTANT: You must temporarily disable SRT when changing RAID modes. Make the change
and then re-enable SRT. Failure to temporarily disable this feature will prevent you from creating or
changing RAID volumes.

@NOTE: HP does not support SRT with self-encrypting drives (SEDs).

Removing or replacing the service door

/\ CAUTION: To prevent information loss or an unresponsive system:

Save your work and shut down the computer before adding or replacing a memory module or hard
drive.

If you are not sure whether the computer is off or in Hibernation, turn the computer on by pressing the
power button. Then shut down the computer through the operating system.

Removing the service door

Remove the service door to access the memory module slot, hard drive, regulatory label, and other
components.

To remove the service door:

1.  Remove the battery (see Inserting or removing the battery on page 43).

2. With the battery bay toward you, slide the service door release latch (1) to the left, remove the
screw (if the optional screw is being used) (2), and then slide the release latch again (3) to
release the service door.
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3. Slide the service door toward the front of the computer (4) and lift (5) to remove the service door.

Replacing the service door

Replace the service door after accessing the memory module slot, hard drive, regulatory label, and
other components.

To replace the service door:

1. Tilt down the service door to align the front edge of the service door near the front edge of the
computer (1).

2. Insert the alignment tabs (2) on the rear edge of the service door with the notches on the
computer.

3. Slide the service door toward the battery bay until the service door snaps into place.
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4. With the battery bay toward you, slide the service door release latch to the left (3), and if you
choose to, insert and tighten the optional screw (4) to hold the service door in place. Slide the
release latch to the right to lock the service door (5).

@NOTE: If you want to use the optional screw, it is stored on the inside of the service door.

5. Insert the battery (see Inserting or removing the battery on page 43).

Replacing or upgrading the hard drive

/\ CAUTION: To prevent information loss or an unresponsive system:

Shut down the computer before removing the hard drive from the hard drive bay. Do not remove the
hard drive while the computer is on, in the Sleep state, or in Hibernation.

If you are not sure whether the computer is off or in Hibernation, turn the computer on by pressing the
power button. Then shut down the computer through the operating system.

Intel Smart Response Technology (select models only)

Intel® Smart Response Technology (SRT) is an Intel® Rapid Storage Technology (RST) caching
feature that significantly enhances computer system performance. SRT allows computers with an
SSD mSATA module to be used as cache memory between the system memory and the hard disk
drive. This provides the advantage of having a hard disk drive (or a RAID volume) for maximum
storage capacity while simultaneously delivering SSD enhanced system performance experience.

If you add or upgrade a hard drive and intend to set a RAID volume, you must temporarily disable
SRT, set the RAID volume and then enable SRT. To temporarily disable SRT;

1. Select Start > All Programs > Intel > Rapid Storage Technology.
2. Click Disable acceleration on the Accelerate tab.

3. Wait for the Acceleration Mode to complete.
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@IMPORTANT: You must temporarily disable SRT when changing RAID modes. Make the change
and then re-enable SRT. Failure to temporarily disable this feature will prevent you from creating or
changing RAID volumes.

@NOTE: HP does not support SRT with self-encrypting drives (SEDs).

Removing the hard drive

%NOTE: Before replacing a hard drive or changing the RAID volume see Intel Smart Response
Technology (select models only) on page 59.

To remove a hard drive:

Save your work and shut down the computer.

Disconnect AC power and external devices connected to the computer.
Turn the computer upside down on a flat surface.

Remove the battery (see Inserting or removing the battery on page 43).

Remove the service door (see Removing or replacing the service door on page 57).

Loosen the two hard drive cover screws on the back of the hard drive (1).

Loosen the two smart card holder screws (2).
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Open the smart card holder (3) to a vertical position.

9. Loosen the hard drive screw (1). Pull the hard drive tab (2) to the right to disconnect the hard
drive.
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10. Lift the hard drive (3), and then pull the hard drive out of the hard drive bay.

11. Remove the four screws (1) on the hard drive bracket and remove the hard drive bracket (2).

E%‘fNOTE: The new hard drive may have a bracket attached. If a bracket is not included, reverse
this procedure to place the bracket onto the new hard drive.
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Installing a hard drive
To install the hard drive:
1. Lower the hard drive (1) into the hard drive bay.
2. Pull the hard drive tab (2) to the left until the hard drive is fully seated

3. Tighten the screw (3) to secure the hard drive.

4. Close the smart card holder (1).
5. Tighten the smart card holder screws (2).

6. Tighten the hard drive cover screws (3).

7. Replace the service door (see Removing or replacing the service door on page 57).
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8. Replace the battery (see Inserting or removing the battery on page 43).

9. Turn the computer right-side up, and then reconnect AC power and external devices to the
computer.

10. Turn on the computer.
Replacing a drive in the upgrade bay
The upgrade bay can hold either a hard drive or an optical drive.

Replacing a hard drive

ACAUTION: To prevent information loss or an unresponsive system:

Shut down the computer before removing the hard drive from the upgrade bay. Do not remove the
hard drive while the computer is on, in the Sleep state, or in Hibernation.

If you are not sure whether the computer is off or in Hibernation, turn the computer on by pressing the
power button. Then shut down the computer through the operating system.

To remove a hard drive from the upgrade bay:

1. Save your work.

Shut down the computer and close the display.

Disconnect all external devices connected to the computer.

Unplug the power cord from the AC outlet.

Turn the computer upside down on a flat surface, with the upgrade bay toward you.

Remove the battery (see Inserting or removing the battery on page 43).

Remove the service door (see Removing or replacing the service door on page 57).

Loosen the upgrade bay screw (1).

Using a flat-bladed screwdriver, gently push the tab to release the hard drive (2).
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Remove the hard drive from the upgrade bay (3).
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To install a hard drive in the upgrade bay:

1.
2,

6.

Turn the computer upside down on a flat surface, with the upgrade bay toward you.

Insert the hard drive (1) into the upgrade bay, and then tighten the upgrade bay screw (2).

Replace the service door (see Removing or replacing the service door on page 57).

Insert the battery (see Inserting or removing the battery on page 43).

Turn the computer right-side up, and then reconnect AC power and external devices to the
computer.

Turn on the computer.

Replacing an optical drive

ACAUTION: To prevent information loss or an unresponsive system:

Shut down the computer before removing the optical drive from the upgrade bay. Do not remove the
optical drive while the computer is on, in the Sleep state, or in Hibernation.

If you are not sure whether the computer is off or in Hibernation, turn the computer on by pressing the
power button. Then shut down the computer through the operating system.

To remove an optical drive from the upgrade bay:

1.
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Save your work.

Shut down the computer and close the display.

Disconnect all external devices connected to the computer.

Unplug the power cord from the AC outlet.

Turn the computer upside down on a flat surface, with the upgrade bay toward you.

Remove the battery (see Inserting or removing the battery on page 43).

Remove the service door (see Removing or replacing the service door on page 57).

Loosen the upgrade bay screw (1).
Using a flat-bladed screwdriver, gently push the tab to release the optical drive (2).

Remove the optical drive from the upgrade bay (3).
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To install an optical drive in the upgrade bay:

1. Turn the computer upside down on a flat surface, with the upgrade bay toward you.
2. Insert the optical drive into the upgrade bay (1).

3. Tighten the upgrade bay screw (2).

4. Replace the service door (see Removing or replacing the service door on page 57).

5. Insert the battery (see Inserting or removing the battery on page 43).

6. Turn the computer right-side up, and then reconnect AC power and external devices to the
computer.

7.  Turn on the computer.
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Improving hard drive performance

Using Disk Defragmenter

As you use the computer, files on the hard drive become fragmented. Disk Defragmenter
consolidates the fragmented files and folders on the hard drive so that the system can run more
efficiently.

E/?’NOTE: It is not necessary to run Disk Defragmenter on solid-state drives.

After you start Disk Defragmenter, it works without supervision. Depending on the size of your hard
drive and the number of fragmented files, Disk Defragmenter may take more than an hour to
complete. You may want to set it to run during the night or at another time when you do not need
access to your computer.

HP recommends defragmenting your hard drive at least once a month. You may set Disk
Defragmenter to run on a monthly schedule, but you can defragment your computer manually at any
time.

To run Disk Defragmenter:
1. Connect the computer to AC power.

2. From the Start screen, type disk, click Settings, and then select Defragment and optimize
your drives.

3. Click Optimize.

= NOTE: Windows includes the User Account Control feature to improve the security of your
computer. You may be prompted for your permission or password for tasks such as installing
software, running utilities, or changing Windows settings. Refer to Help and Support for more
information. From the Start screen, type h, and then select Help and Support.

For additional information, access the Disk Defragmenter software Help.

Using Disk Cleanup

Disk Cleanup searches the hard drive for unnecessary files that you can safely delete to free up disk
space and help the computer to run more efficiently.

To run Disk Cleanup:

1. From the Start screen, type disk, click Settings, and then select Free disk space by deleting
unnecessary files.

2. Follow the on-screen instructions.

Using HP 3D DriveGuard (select models only)

HP 3D DriveGuard protects the hard drive by parking the drive and halting data requests under either
of the following conditions:

e  You drop the computer.
e You move the computer with the display closed while the computer is running on battery power.

A short time after the end of one of these events, HP 3D DriveGuard returns the hard drive to normal
operation.

@NOTE: Because solid-state drives (SSD) lack moving parts, HP 3D DriveGuard is unnecessary.
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E‘%NOTE: Hard drives in the primary hard drive bay or in the secondary hard drive bay are protected
by HP 3D DriveGuard. Hard drives installed in optional docking devices or connected to USB ports
are not protected by HP 3D DriveGuard.

For more information, see the HP 3D DriveGuard software Help.

Identifying HP 3D DriveGuard status

The hard drive light on the computer changes color to show that a drive in the primary hard drive bay
or a drive in the secondary hard drive bay (select models only) is parked. To determine whether
drives are currently protected or whether a drive is parked, use the icon on the Windows desktop in
the notification area, at the far right of the taskbar:

e If the software is enabled, a green check mark is superimposed over the hard drive icon.
e If the software is disabled, a red X is superimposed over the hard drive icon.
e |[f the drives are parked, a yellow moon is superimposed over the hard drive icon.

If the icon in the notification area, at the far right of the taskbar, is not enabled, follow these steps to
enable it:

1. From the Start screen, type c, and then select Control Panel.
2. Select Hardware and Sound > HP 3D DriveGuard.
@NOTE: If prompted by User Account Control, click Yes.

3. From the Icon in system tray row, click Show.

4. Click OK.

Managing power with a parked hard drive
If HP 3D DriveGuard has parked the drive, the computer will behave in the following ways:
e  The computer will not shut down.
e  The computer will not initiate Sleep.
e  The computer will not activate battery alarms set on the Alarms tab in Power Options.

Before you move the computer, HP recommends that you either shut it down or initiate Sleep.

Using HP 3D DriveGuard software

The HP 3D DriveGuard software enables you to perform the following tasks:

° Enable and disable HP 3D DriveGuard.

@’NOTE: Depending on your user privileges, you may be unable to enable or disable HP 3D
DriveGuard. Privileges for non-administrator users can be changed by members of an
administrator group.

e Determine whether a drive in the system is supported.
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To open the software and change settings, follow these steps:

1. Double-click the icon on the Windows desktop in the notification area, at the far right of the
taskbar.

Right-click the icon in the notification area, at the far right of the taskbar, and then select
Settings.

2. Click the appropriate button to change settings.
3. Click OK.

Using optical drives (select models only)
Optical drives include the following:
e CD
e DVD
e  Blu-ray (BD)

Identifying the installed optical drive

A From the Start screen, type e, click File Explorer, and select Computer.

A list of all the devices installed in your computer, including your optical drive, is displayed.

Inserting an optical disc

Tray-load

1. Turn on the computer.

2. Press the release button (1) on the drive bezel to release the disc tray.
3. Pull out the tray (2).
4

Hold the disc by the edges to avoid touching the flat surfaces and position the disc label-side up
over the tray spindle.

@NOTE: If the tray is not fully accessible, tilt the disc carefully to position it over the spindle.
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5. Gently press the disc (3) down onto the tray spindle until the disc snaps into place.

6. Close the disc tray.

r__iﬁ??NOTE: After you insert a disc, a short pause is normal. If you have not selected a media player, an
AutoPlay dialog box opens. It prompts you to select how you want to use the media content.

Removing an optical disc

Tray-load

There are 2 ways to remove a disc, depending on whether the disc tray opens normally or not.

When the disc tray opens normally

1. Press the release button (1) on the drive bezel to release the disc tray, and then gently pull out
the tray (2) until it stops.
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2. Remove the disc (3) from the tray by gently pressing down on the spindle while lifting the outer
edges of the disc. Hold the disc by the edges and avoid touching the flat surfaces.

@NOTE: If the tray is not fully accessible, tilt the disc carefully as you remove it.

o

3. Close the disc tray and place the disc in a protective case.

When the disc tray fails to open normally
1. Insert the end of a paper clip (1) into the release access in the front bezel of the drive.

2. Press in gently on the paper clip until the tray is released, and then pull out the tray (2) until it
stops.
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3.  Remove the disc (3) from the tray by gently pressing down on the spindle while lifting the outer
edges of the disc. Hold the disc by the edges and avoid touching the flat surfaces.

@NOTE: If the tray is not fully accessible, tilt the disc carefully as you remove it.

I

r""—'ﬂ‘

4. Close the disc tray and place the disc in a protective case.
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Sharing optical drives

Although your computer may not have an integrated optical drive, you can access software and data,
and install applications, by sharing an optical drive connected to another computer in your network.
Sharing drives is a feature of the Windows operating system that allows a drive on one computer to
be accessible to other computers on the same network.

=¥ NOTE: You must have a network set up in order to share an optical drive; see Connecting to a
network on page 16 for additional information on setting up a network.

=¥ NOTE: Some discs, such as DVD movies and game discs, may be copy-protected and therefore
unusable through DVD or CD drive sharing.

To share an optical drive from the computer with the optical drive you are sharing:
1. From the Start screen, type e, click File Explorer, and select Computer.
Right-click the optical drive you want to share, and click Properties.

Click the Sharing tab, and then click Advanced Sharing.

Select the Share this folder check box.

Type a name for the optical drive in the Share name text box.

Click Apply, and then click OK.
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From the Start screen, type n. In the search box, type network and sharing, click Settings,
and then select from the displayed options.

Using RAID (select models only)

Redundant Arrays of Independent Disks (RAID) technology allows a computer to use two or more
hard disks at the same time. RAID treats multiple drives as one contiguous drive, either through
hardware or software settings. If multiple disks are set up to work together in this fashion, they are
referred to as a RAID array.
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9 Security

Protecting the computer

Standard security features provided by the Windows operating system and the non-Windows
Computer Setup utility (BIOS) can protect your personal settings and data from a variety of risks.

E%?NOTE: Security solutions are designed to act as deterrents. These deterrents may not prevent a

product from being mishandled or stolen.

=¥ NOTE: Before you send your computer for service, back up and delete confidential files, and

remove all password settings.

@NOTE: Some features listed in this chapter may not be available on your computer.

E%?NOTE: Your computer supports Computrace, which is an online security-based tracking and
recovery service available in select regions. If the computer is stolen, Computrace can track the
computer if the unauthorized user accesses the Internet. You must purchase the software and

subscribe to the service in order to use Computrace. For information about ordering the Computrace

software, go to the HP website at http://www.hpshopping.com.

E%?NOTE: If a webcam is installed or connected to the computer, and if the Face Recognition program

is installed, you can set the security level for Face Recognition to balance the ease of use and the
difficulty of breaching the security of the computer. Refer to the Face Recognition software Help.

Computer risk

Security feature

Unauthorized use of the computer

HP ProtectTools Security Manager (select models only), in
combination with a password, smart card, contactless card,
registered face scenes, registered fingerprints, or other
authentication credential

Unauthorized access to Computer Setup (f10)

BIOS administrator password in Computer Setup*

Unauthorized access to the contents of a hard drive

DriveLock password in Computer Setup*

Unauthorized startup from an optical drive, diskette drive, or

internal network adapter

Boot options feature in Computer Setup*

Unauthorized access to a Windows user account

Windows user password

Unauthorized access to data

e  Firewall software
e  Windows updates

e  Drive Encryption for HP ProtectTools

Unauthorized access to Computer Setup settings and other

system identification information

BIOS administrator password in Computer Setup*

Unauthorized removal of the computer

Security cable slot (used with an optional security cable)

*Computer Setup is a preinstalled, ROM-based utility that can be used even when the operating system is not working or will

not load. You can use either a pointing device (TouchPad, pointing stick, or USB mouse) or the keyboard to navigate and

make selections in Computer Setup.

Protecting the computer

73


http://www.hpshopping.com

Using passwords

A password is a group of characters that you choose to secure your computer information. Several
types of passwords can be set, depending on how you want to control access to your information.
Passwords can be set in Windows or in the non-Windows Computer Setup utility that is preinstalled
on the computer.

e  Setup and DriveLock passwords are set in Computer Setup and are managed by the system
BIOS.

The embedded security password, which is an HP ProtectTools Security Manager password,
can be enabled in Computer Setup to provide BIOS password protection in addition to its normal
HP ProtectTools functions. The embedded security password is used with the optional
embedded security chip.

Windows passwords are set only in the Windows operating system.

If you forget the BIOS administrator password set in Computer Setup, you can use HP SpareKey
to access the utility.

If you forget both the DriveLock user password and the DriveLock master password set in
Computer Setup, the hard drive that is protected by the passwords is permanently locked and
can no longer be used.

You can use the same password for a Computer Setup feature and for a Windows security feature.
You can also use the same password for more than one Computer Setup feature.

Use the following tips for creating and saving passwords:

e  When creating passwords, follow requirements set by the program.

e  Write down your passwords and store them in a secure place away from the computer.

e Do not store passwords in a file on the computer.

The following tables list commonly used Windows and BIOS administrator passwords and describe

their functions.

Setting passwords in Windows

Password Function

Administrator password* Protects access to a Windows administrator-level account.

NOTE: This password cannot be used to access Computer
Setup contents.

User password* Protects access to a Windows user account.

*For information about setting a Windows administrator password or a Windows user password, from the Start screen, type
h, and then select Help and Support.
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Setting passwords in Computer Setup

Password Function
BIOS administrator password* Protects access to Computer Setup.
DriveLock master password* Protects access to the internal hard drive that is protected by

DriveLock. It is also used to remove DrivelLock protection.
This password is set under DriveLock Passwords during the
enable process.

DriveLock user password* Protects access to the internal hard drive that is protected by
DriveLock, and is set under DriveLock Passwords during the
enable process.

TPM Embedded Security Device (select models only) Available/Hidden

e |f the administrator password is set, you can select
Available.

° If you select Hidden, the TPM device is not visible in
the operating system.

TPM Status (select models only) Enabled/disabled

e If the administrator password is not set or if the TPM
Security Device is set to Hidden, this entry is hidden.

e  This value reflects the current physical state for the
TPM. The state is enabled or disabled by the
Embedded Security State setting.

Embedded Security State (select models only) No Operation/Disabled/ Enabled

e If the administrator password is not set or if TPM
Security Device is set to Hidden, this entry is hidden.

° You can enable or disable the TPM function.

e  The next time the computer is restarted after the TPM
function is set, this value is set to No Operation.

TPM Set to Factory Defaults (select models only) No/Yes

e If the administrator password is not set or if the TPM
Security Device is set to Hidden, this entry is hidden.

e If the Embedded Security State is set to Enabled,
selectYes to reset the TPM to factory settings, and then
press 10 to save and exit. A confirmation message is
displayed to Clear the TPM. Press f1 to reset the TPM,
or press f2 to cancel the action.

*For details about each of these passwords, see the following topics.

Managing a BIOS administrator password

To set, change, or delete this password, follow these steps:
Setting a new BIOS administrator password

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

2. Press f10 to enter Computer Setup.
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Use a pointing device or the arrow keys to select Security > Setup BIOS Administrator
Password, and then press enter.

When prompted, type a password.
When prompted, type the new password again to confirm.

To save your changes and exit Computer Setup, click the Save icon and then follow the on-
screen instructions.

Use the arrow keys to select File > Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.

Changing a BIOS administrator password

1.

Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

Press 10 to enter Computer Setup.

Use a pointing device or the arrow keys to select Security > Change Password, and then press
enter.

When prompted, type your current password.
When prompted, type your new password again to confirm.

To save your changes and exit Computer Setup, click the Save icon in the lower-left corner of
the screen, and then follow the on-screen instructions.

Use the arrow keys to select File > Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.

Deleting a BIOS administrator password

1.

[
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Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

Press f10 to enter Computer Setup.

Use a pointing device or the arrow keys to select Security > Change Password, and then press
enter.

When prompted, type your current password.

When prompted for the new password, leave the field empty, and then press enter.

Read the warning. To continue, select YES.

When prompted to type your new password again, leave the field empty, and then press enter.

To save your changes and exit Computer Setup, click the Save icon in the lower-left corner of
the screen, and then follow the on-screen instructions.

Use the arrow keys to select File > Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.
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Entering a BIOS administrator password

At the BIOS administrator password prompt, type your password (using the same kind of keys you
used to set the password), and then press enter. After 3 unsuccessful attempts to enter the BIOS
administrator password, you must restart the computer and try again.

Managing a Computer Setup DriveLock password

/\ CAUTION: To prevent the DriveLock-protected hard drive from becoming permanently unusable,
record the DriveLock user password and the DriveLock master password in a safe place away from
your computer. If you forget both DriveLock passwords, the hard drive will be permanently locked and
can no longer be used.

DriveLock protection prevents unauthorized access to the contents of a hard drive. DriveLock can be
applied only to the internal hard drive(s) of the computer. After DriveLock protection is applied to a
drive, a password must be entered to access the drive. The drive must be inserted into the computer
or an advanced port replicator in order for it to be accessed by the DrivelLock passwords.

To apply DriveLock protection to an internal hard drive, a user password and a master password
must be set in Computer Setup. Note the following considerations about using DriveLock protection:

After DriveLock protection is applied to a hard drive, the hard drive can be accessed only by
entering either the user password or the master password.

The owner of the user password should be the day-to-day user of the protected hard drive. The
owner of the master password may be either a system administrator or the day-to-day user.

The user password and the master password can be identical.

You can delete a user password or master password only by removing DriveLock protection
from the drive. DriveLock protection can be removed from the drive only with the master
password.

Setting a DriveLock password

To set a DriveLock password in Computer Setup, follow these steps:

1.

o ~ w D

© ® N 9o

10.

Turn on the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

Press 10 to enter Computer Setup.
Use a pointing device or the arrow keys to select Security > DriveLock, and then press enter.
Click Set DriveLock Password (global).

Use a pointing device or the arrow keys to select the hard drive you want to protect, and then
press enter.

Read the warning. To continue, select YES.

When prompted, type a master password, and then press enter.

When prompted, type the master password again to confirm, and then press enter.
When prompted, type a user password, and then press enter.

When prompted, type the user password again to confirm, and then press enter.
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11.

To confirm DriveLock protection on the drive you have selected, type DriveLock in the
confirmation field, and then press enter.

E’/?‘?NOTE: The DriveLock confirmation is case sensitive.

12.

To save your changes and exit Computer Setup, click the Save icon in the lower-left corner of
the screen, and then follow the on-screen instructions.

Use the arrow keys to select File > Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.

Entering a DriveLock password

Be sure that the hard drive is inserted into the computer (not into an optional docking device or
external MultiBay).

At the DriveLock Password prompt, type your user or master password (using the same kind of
keys you used to set the password), and then press enter.

After 2 incorrect attempts to enter the password, you must shut down the computer and try again.

Changing a DriveLock password

To change a DriveLock password in Computer Setup, follow these steps:

1.
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Turn on the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

Press f10 to enter Computer Setup.
Use a pointing device or the arrow keys to select Security > DriveLock, and then press enter.

Use a pointing device or the arrow keys to select Set DriveLock Password, and then press
enter.

Use the arrow keys to select an internal hard drive, and then press enter.

Use a pointing device or the arrow keys to select Change Password.

When prompted, type your current password, and then press enter.

When prompted, type a new password, and then press enter.

When prompted, type the new password again to confirm, and then press enter.

To save your changes and exit Computer Setup, click the Save icon in the lower-left corner of
the screen, and then follow the on-screen instructions.

Use the arrow keys to select File > Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.
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Removing DriveLock protection

To remove DrivelLock protection in Computer Setup, follow these steps:

1. Turn on the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

2. Press f10 to enter Computer Setup.

3. Use a pointing device or the arrow keys to select Security > DriveLock, and then press enter.

>

Use a pointing device or the arrow keys to select Set DriveLock Password, and then press
enter.

Use a pointing device or the arrow keys to select an internal hard drive, and then press enter.
Use a pointing device or the arrow keys to select Disable protection.

Type your master password, and then press enter.

© N o o

To save your changes and exit Computer Setup, click the Save icon and then follow the on-
screen instructions.

Use the arrow keys to select File > Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.

Using Computer Setup Automatic DriveLock

In a multiple-user environment, you can set an Automatic DriveLock password. When the Automatic
DriveLock password is enabled, a random user password and a DriveLock master password will be
created for you. When any user passes the password credential, the same random user and
DriveLock master password will be used to unlock the drive.

E}fNOTE: You must have a BIOS administrator password before you can access the Automatic
Drivelock features.

Entering an Automatic DriveLock password

To enable an Automatic DriveLock password in Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

2. Press f10 to enter Computer Setup.

3. Use a pointing device or the arrow keys to select Security > Automatic DriveLock, and then
press enter.

4. Use a pointing device or the arrow keys to select an internal hard drive, and then press enter.
5. Read the warning. To continue, select YES.

6. To save your changes and exit Computer Setup, click the Save icon and then follow the on-
screen instructions.

Use the arrow keys to select File > Save Changes and Exit, and then press enter.
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Removing Automatic DriveLock protection
To remove DrivelLock protection in Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

2. Press f10 to enter Computer Setup.

3. Use a pointing device or the arrow keys to select Security > Automatic DriveLock, and then
press enter.

4. Use a pointing device or the arrow keys to select an internal hard drive, and then press enter.
5. Use a pointing device or the arrow keys to select Disable protection.

6. To save your changes and exit Computer Setup, click the Save icon in the lower-left corner of
the screen, and then follow the on-screen instructions.

Use the arrow keys to select File > Save Changes and Exit, and then press enter.

Using antivirus software

When you use the computer to access e-mail, a network, or the Internet, you potentially expose it to
computer viruses. Computer viruses can disable the operating system, programs, or utilities, or cause
them to function abnormally.

Antivirus software can detect most viruses, destroy them, and, in most cases, repair any damage they
have caused. To provide ongoing protection against newly discovered viruses, antivirus software
must be kept up to date.

An antivirus program may be preinstalled on your computer. It is strongly recommended that you use
an antivirus program of your choice in order to fully protect your computer.

To access Help and Support, type viruses in the Search box in Help and Support. From the Start
screen, type h, and then select Help and Support.

Using firewall software

Firewalls are designed to prevent unauthorized access to a system or network. A firewall can be a
software program you install on your computer and/or network, or it can be a solution made up of
both hardware and software.

There are two types of firewalls to consider:
e Host-based firewalls—Software that protects only the computer it is installed on.

e Network-based firewalls—Installed between your DSL or cable modem and your home network
to protect all the computers on the network.

When a firewall is installed on a system, all data sent to and from the system is monitored and
compared with a set of user-defined security criteria. Any data that does not meet those criteria is
blocked.

Your computer or networking equipment may already have a firewall installed. If not, firewall software
solutions are available.
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=¥ NOTE: Under some circumstances a firewall can block access to Internet games, interfere with
printer or file sharing on a network, or block authorized e-mail attachments. To temporarily resolve the
problem, disable the firewall, perform the task that you want to perform, and then reenable the
firewall. To permanently resolve the problem, reconfigure the firewall.

Installing critical security updates

A CAUTION: Microsoft® sends out alerts regarding critical updates. To protect the computer from
security breaches and computer viruses, install all critical updates from Microsoft as soon as you
receive an alert.

Updates to the operating system and other software may have become available after the computer
left the factory. To be sure that all available updates are installed on the computer, observe these
guidelines:

e Run Windows Update as soon as possible after you set up your computer.
e Run Windows Update monthly thereafter.

e  Obtain updates to Windows and other Microsoft programs, as they are released, from the
Microsoft website and through the updates link in Help and Support. To access Help and
Support, from the Start screen, type h, and then select Help and Support.

Using HP ProtectTools Security Manager (select models
only)
HP ProtectTools Security Manager software is preinstalled on select computer models. This software
can be accessed through Windows Control Panel. It provides security features that help protect

against unauthorized access to the computer, networks, and critical data. For more information, see
the HP ProtectTools software Help.

Installing an optional security cable

E‘jNOTE: A security cable is designed to act as a deterrent, but it may not prevent the computer from
being mishandled or stolen.

@NOTE: The security cable slot on your computer may look slightly different from the illustration in
this section. Refer to the Getting to know your computer on page 4 section for the location of the
security cable slot on your computer.

1. Loop the security cable around a secured object.
2. Insert the key (1) into the cable lock (2).

3. Insert the cable lock into the security cable slot on the computer (3), and then lock the cable lock
with the key.
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Using the fingerprint reader (select models only)

Integrated fingerprint readers are available on select computer models. In order to use the fingerprint
reader, you must set up a user account with a password on the computer. This account allows you to
log on to your computer with a swipe of a designated finger. You may also use the fingerprint reader
to fill in password fields on websites and other programs that require a logon. Refer to the fingerprint
software Help for instructions.

After you create your fingerprint identity, you can set up a Single Sign On service that allows you to
use your fingerprint scanner to create credentials for any application that requires a user name and

password.

Locating the fingerprint reader

The fingerprint reader is a small metallic sensor that is located in one of the following areas of your
computer:

e  Near the bottom of the TouchPad

e  On the right side of the keyboard

e  On the upper-right side of the display
e  On the left side of the display

Depending on your computer model, the reader may be oriented horizontally or vertically. Both
orientations require that you swipe your finger perpendicular to the metallic sensor. Refer to the
Getting to know your computer on page 4 section for the location of the fingerprint reader on your

computer.
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10 Maintenance

Adding or replacing memory modules

The computer has two memory module compartments. The capacity of the computer can be
upgraded by adding a memory module to the vacant expansion memory module slot or by upgrading
the existing memory module in the primary memory module slot.

AWARNING! To reduce the risk of electric shock and damage to the equipment, unplug the power
cord and remove all batteries before installing a memory module.

/\ CAUTION: Electrostatic discharge (ESD) can damage electronic components. Before beginning
any procedure, ensure that you are discharged of static electricity by touching a grounded metal
object.

CAUTION: To prevent information loss or an unresponsive system:

Shut down the computer before adding or replacing memory modules. Do not remove a memory
module while the computer is on, in the Sleep state, or in Hibernation.

If you are not sure whether the computer is off or in Hibernation, turn the computer on by pressing the
power button. Then shut down the computer through the operating system.

E/i"NOTE: To use a dual-channel configuration when adding a second memory module, be sure that
both memory modules are identical.

E%?NOTE: The primary memory is located in the bottom memory slot and the expansion memory is
located in the top memory slot.

To add or replace a memory module:
1. Save your work and shut down the computer.
Disconnect AC power and external devices connected to the computer.

Remove the battery (see Inserting or removing the battery on page 43).

2
3
4. Remove the service door (see Removing or replacing the service door on page 57).
5. If you are replacing a memory module, remove the existing memory module:

a. Pull away the retention clips (1) on each side of the memory module.

The memory module tilts up.
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b. Grasp the edge of the memory module (2), and then gently pull the memory module out of
the memory module slot.

/\ CAUTION: To prevent damage to the memory module, hold the memory module by the
edges only. Do not touch the components on the memory module.

To protect a memory module after removal, place it in an electrostatic-safe container.

6. Insert a new memory module:

/\ CAUTION: To prevent damage to the memory module, hold the memory module by the edges
only. Do not touch the components on the memory module.

a. Align the notched edge (1) of the memory module with the tab in the memory module slot.

b. With the memory module at a 45-degree angle from the surface of the memory module
compartment, press the module (2) into the memory module slot until it is seated.
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c. Gently press the memory module (3) down, applying pressure to both the left and right
edges of the memory module, until the retention clips snap into place.

/\ CAUTION: To prevent damage to the memory module, be sure that you do not bend the
memory module.

7. Replace the service door (see Removing or replacing the service door on page 57).

8. Insert the battery (see Inserting or removing the battery on page 43).

9. Connect AC power and external devices to the computer.

10. Turn on the computer.

Adding or replacing the memory module underneath the
keyboard (select models only)

A CAUTION: To prevent information loss or an unresponsive system:

Shut down the computer before adding or replacing memory modules. Do not remove a memory
module while the computer is on, in the Sleep state, or in Hibernation.

If you are not sure whether the computer is off or in Hibernation, turn the computer on by pressing the
power button. Then shut down the computer through the operating system.

To replace the primary memory module underneath the keyboard:
1. Save your work and shut down the computer.
2. Disconnect AC power and external devices connected to the computer.

3. Turn the computer upside down on a flat surface, with the battery bay away from you.
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4. Remove the battery (see Inserting or removing the battery on page 43).

5. Remove the service door (see Removing or replacing the service door on page 57).

6. Remove the hard drive or optical drive from the upgrade bay (see Replacing a drive in the
upgrade bay on page 63).

7. Remove the keyboard:

a. With the computer upside down, loosen the three captive keyboard screws on the bottom of
the computer.

b. Turn the computer on its side with the display open to access the upgrade bay. Gently push
the release tab up as shown to release the keyboard.
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c. Turn the computer right-side up and gently release the five tabs from right to left along the
top edge of the keyboard.

E%V?NOTE: Do not disconnect the keyboard cable. To avoid disconnecting the keyboard
cable, do not pull the keyboard away from the computer.

d. Restthe keyboard on the TouchPad.

8. If you are replacing a memory module, remove the existing memory module:
a. Pull away the retention clips (1) on each side of the memory module.
The memory module tilts up.

b. Grasp the edge of the memory module (2), and then gently pull the memory module out of
the memory module slot.

/\ CAUTION: To protect a memory module after removal, place it in an electrostatic-safe
container.
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@NOTE: Memory modules are designed with a notch to prevent incorrect insertion into the
memory module slot.

9. Line up the notch (1), slide the memory module into place (2) and gently push the memory
module into place (3).
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10. Replace the keyboard:

a. Lift up the keyboard and flip it over (1), resting it on the base enclosure.

b. Slide the keyboard tabs (2) into the base enclosure slots.

c. Gently press the keyboard (3) into place, working from left to right along the top edge of the
keyboard so that it snaps into place.

%"/'VNOTE: Gently push along the top of the keyboard to ensure all tabs are in place.
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d. Inspect the tab in the upgrade bay to ensure the keyboard is locked. If not, gently push the
tab down until it is locked in place.

e. Turn the computer upside down, and then tighten the three captive keyboard screws (4) to
lock the keyboard into place.

11. Replace the service door (see Removing or replacing the service door on page 57).

12. Insert the battery (see Inserting or removing the battery on page 43.)

13. Replace the hard drive or optical drive in the upgrade bay. (See Replacing a drive in the upgrade
bay on page 63.)

14. Turn on the computer.
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Cleaning your computer

Cleaning products

Use the following products to safely clean and disinfect your computer:

e  Dimethyl benzyl ammonium chloride 0.3 percent maximum concentration (For example:
germicidal disposable wipes. These wipes come in a variety of brand names.)

e Alcohol-free glass cleaning fluid

e  Water with mild soap solution

e Dry microfiber cleaning cloth or a chamois (static-free cloth without oil)
e  Static-free cloth wipes

/\ CAUTION: Avoid the following cleaning products:

Strong solvents, such as alcohol, acetone, ammonium chloride, methylene chloride, and
hydrocarbons, which can permanently damage the surface of the computer.

Fibrous materials, such as paper towels, which can scratch the computer. Over time, dirt particles
and cleaning agents can get trapped in the scratches.

Cleaning procedures

Follow the procedures in this section to safely clean your computer.

/\ WARNING! To prevent electric shock or damage to components, do not attempt to clean your
computer while it is turned on:

Turn off the computer.
Disconnect external power.
Disconnect all powered external devices.

/\ CAUTION: Do not spray cleaning agents or liquids directly on any computer surface. Liquids
dripped on the surface can permanently damage internal components.

Cleaning the display

Gently wipe the display using a soft, lint-free cloth moistened with an alcohol-free glass cleaner. Be
sure that the display is dry before closing the display.

Cleaning the sides and cover

To clean and disinfect the sides and cover, use a soft microfiber cloth or chamois moistened with one
of the cleaning solutions listed previously or use an acceptable germicidal disposable wipe.

“»NOTE: When cleaning the cover of the computer, use a circular motion to aid in removing dirt and
debris.

Cleaning the TouchPad and keyboard

AWARNING! To reduce the risk of electric shock or damage to internal components, do not use a
vacuum cleaner attachment to clean the keyboard. A vacuum cleaner can deposit household debris
on the keyboard surface.
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/\ CAUTION: When cleaning the TouchPad and keyboard, do not let liquids drip between the keys.
This can permanently damage internal components.

e To clean and disinfect the TouchPad and keyboard, use a soft microfiber cloth or chamois
moistened with one of the cleaning solutions listed previously or use an acceptable germicidal
disposable wipe.

e To prevent keys from sticking and to remove dust, lint, and particles from the keyboard, use a
can of compressed air with a straw extension.

Using the DreamColor display (select models only)

Computer models with the HP DreamColor display include the preinstalled HP Mobile Display
Assistant software. You can use this program to adjust display color settings such as preset color
space, white point/color temperature, and luminance/brightness.

A To access Mobile Display Assistant, click the Mobile Display Assistant icon in the notification
area, at the far right of the taskbar, or select Start > All Programs > Productivity and Tools >
Mobile Display Assistant.

Updating programs and drivers

HP recommends that you update your programs and drivers on a regular basis with the latest
versions. Go to http://www.hp.com/support to download the latest versions. You can also register to
receive automatic update notifications when they become available.

Using SoftPaq Download Manager

HP SoftPaq Download Manager (SDM) is a tool that provides quick access to SoftPaq information for
HP business computers without requiring the SoftPaq number. Using this tool, you can easily search
for SoftPags, and then download and unpack them.

SoftPag Download Manager works by reading and downloading, from the HP FTP site, a published
database file containing computer model and SoftPaq information. SoftPaq Download Manager
allows you to specify one or more computer models to determine which SoftPags are available for
download.

SoftPaq Download Manager checks the HP FTP site for updates to the database and software. If
updates are found, they are downloaded and applied automatically.

SoftPaqg Download Manager is available on the HP website. To use SoftPaq Download Manager to
download SoftPags, you must first download and install the program. Go to the HP website at
http://www.hp.com/go/sdm, and follow the instructions to download and install SoftPaq Download
Manager.

To download SoftPags:

A From the Start screen, type s. In the search box, type softpag, and then select HP SoftPaq
Download Manager. Follow the instructions to download SoftPags.

=¢NOTE: If prompted by User Account Control, click Yes.
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11 Backup and recovery

To protect your information, use Windows backup and restore utilities to back up individual files and
folders, back up your entire hard drive, create system repair media (select models only) by using the
installed optical drive (select models only) or an optional external optical drive, or create system
restore points. In case of system failure, you can use the backup files to restore the contents of your
computer.

From the Start screen, type restore, click Settings, and then select from the list of displayed
options.

|‘__*:"/i"NOTE: For detailed instructions on various backup and restore options, perform a search for these
topics in Help and Support. From the Start screen, type h, and then select Help and Support.

In case of system instability, HP recommends that you print the recovery procedures and save them
for later use.

“»NOTE: Windows includes the User Account Control feature to improve the security of your
computer. You may be prompted for your permission or password for tasks such as installing
software, running utilities, or changing Windows settings. Refer to Help and Support for more
information. From the Start screen, type h, and then select Help and Support.

Backing up your information

Recovery after a system failure is as good as your most recent backup. You should create system
repair media and your initial backup immediately after initial system setup. As you add new software
and data files, you should continue to back up your system on a regular basis to maintain a
reasonably current backup. As you add new software and data files, you should continue to back up
your system on a regular basis to maintain a reasonably current backup. The system repair media
(select models only) are used to start up (boot) the computer and repair the operating system in case
of system instability or failure. Your initial and subsequent backups allow you to restore your data and
settings if a failure occurs.

From the Start screen, type backup, click Settings, and then select Save backup copies of your
files with File History.

You can back up your information to an optional external hard drive or a network drive.
Note the following when backing up:

e  Store personal files in the Documents library, and back it up regularly.

e Back up templates that are stored in their associated programs.

e  Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot
of your settings. The screen shot can be a time-saver if you have to reset your preferences.

To create a backup using Backup and Restore:

E%,@NOTE: Be sure that the computer is connected to AC power before you start the backup process.
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E/%"NOTE: The backup process may take over an hour, depending on file size and the speed of the
computer.

1. From the Start screen, type backup, click Settings, and then select from the list of displayed
options.

2. Follow the on-screen instructions to set up your backup, create a system image (select models
only), or create system repair media (select models only).

Performing a system recovery

In case of system failure or instability, the computer provides the following tools to recover your files:

e  Windows recovery tools: You can use Windows Backup and Restore to recover information you
have previously backed up. You can also use Windows Startup Repair to fix problems that might
prevent Windows from starting correctly.

e 11 recovery tools: You can use the f11 recovery tools to recover your original hard drive image.
The image includes the Windows operating system and software programs installed at the
factory.

E/?’NOTE: If you are unable to boot (start up) your computer and you cannot use the system repair
media you previously created (select models only), you must purchase Windows 8 operating system
media to reboot the computer and repair the operating system. For additional information, see Using
Windows 8 operating system media (purchased separately) on page 95.

Using the Windows recovery tools
To recover information you previously backed up:
A From the Start screen, type h, and then select Help and Support.

To recover your information using Startup Repair, follow these steps:

/\ CAUTION: Some Startup Repair options will completely erase and reformat the hard drive. All files
you have created and any software installed on the computer are permanently removed. When
reformatting is complete, the recovery process restores the operating system, as well as the drivers,
software, and utilities from the backup used for recovery.

1. If possible, back up all personal files.
2. If possible, check for the presence of the HP Recovery partition and the Windows partition.
From the Start screen, type e, and then click File Explorer.

From the Start screen, type c, and then select Computer.

E‘%NOTE: If the Windows partition and the HP Recovery partition are not listed, you must recover
your operating system and programs using the Windows 8 operating system DVD and the Driver
Recovery media (both purchased separately). For additional information, see Using Windows 8
operating system media (purchased separately) on page 95.

3. If the Windows partition and the HP Recovery partition are listed, restart the computer. After
Windows has loaded, press and hold the shift key while clicking Restart.

4. Select Startup Repair.

5. Follow the on-screen instructions.
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E‘%NOTE: For additional information on recovering information using the Windows tools, perform a
search for these topics in Help and Support. From the Start screen, type h, and then select Help and
Support.

Using f11 recovery tools

/\ CAUTION: Using f11 completely erases hard drive contents and reformats the hard drive. All files
that you have created and any software that you have installed on the computer are permanently
removed. The f11 recovery tool reinstalls the operating system and HP programs and drivers that
were installed at the factory. Software not installed at the factory must be reinstalled.

To recover the original hard drive image using f11:
1. If possible, back up all personal files.

2. If possible, check for the presence of the HP Recovery partition: From the Start screen, type c,
and then select Computer.

E/?’NOTE: If the HP Recovery partition is not listed, you must recover your operating system and
programs using the Windows 8 operating system media and the Driver Recovery media (both
purchased separately). For additional information, see Using Windows 8 operating system
media (purchased separately) on page 95.

3. If the HP Recovery partition is listed, restart the computer, and then press esc while the “Press
the ESC key for Startup Menu” message is displayed at the bottom of the screen.

4. Press 11 while the “Press <F11> for recovery” message is displayed on the screen.

5. Follow the on-screen instructions.

Using Windows 8 operating system media (purchased separately)

To order a Windows 8 operating system DVD, go to http://www.hp.com/support, select your country
or region, and follow the on-screen instructions. You can also order the DVD by calling support. For
contact information, see the Worldwide Telephone Numbers booklet included with the computer.

/\ CAUTION: Using a Windows 8 operating system media completely erases hard drive contents and
reformats the hard drive. All files that you have created and any software that you have installed on
the computer are permanently removed. When reformatting is complete, the recovery process helps
you restore the operating system, as well as drivers, software, and utilities.

To initiate recovery using a Windows 8 operating system DVD:

E‘%NOTE: This process takes several minutes.

1. If possible, back up all personal files.

2. Restart the computer, and then insert the Windows 8 operating system DVD into the optical
drive before the Windows operating system loads.

3. When prompted, press any keyboard key.

4. Follow the on-screen instructions.

After the repair is completed:

1. Eject the Windows 8 operating system media and then insert the Driver Recovery media.

2. Install the Hardware Enabling Drivers first, and then install Recommended Applications.
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Using Windows Refresh for quick and easy recovery

When your computer is not working properly and you need to regain system stability, the Windows
Refresh option allows you to start fresh and keep what is important to you.

@IMPORTANT: Refresh removes any traditional applications that were not originally installed on the
system at the factory.

@NOTE: During Refresh, a list of removed traditional applications will be saved so that you have a
quick way to see what you might need to reinstall. See Help and Support for instructions on
reinstalling traditional applications. From the Start screen, type h, and then select Help and Support.

@NOTE: You may be prompted for your permission or password when using Refresh. See Windows
Help and Support for more information. From the Start screen, type h, and then select Help and
Support.

To start Refresh:

1. On the Start screen, point to the far-right upper or lower corner of the screen to display the
charms.

2. Click Settings.

3. Click Change PC settings in the bottom-right corner of the screen, and then select General
from the PC settings screen.

4. Under Refresh your PC without affecting your files, select Get started, and follow the on-
screen instructions.

Remove everything and reinstall Windows

Sometimes you want to perform detailed reformatting of your computer, or you want to remove
personal information before you give away or recycle your computer. The process described in this
section provides a speedy, simple way to return the computer to its original state. This option
removes all personal data, apps, and settings from your computer, and reinstalls Windows.

i""‘ IMPORTANT: This option does not provide backups of your information. Before using this option,
back up any personal information you wish to retain.

You can initiate this option by using the 11 key or from the Start screen.
To use the 111 key:
1. Press f11 while the computer boots.
—or—
Press and hold f11 as you press the power button.
2. Select Troubleshoot from the boot options menu.
3. Select Reset your PC, and follow the on-screen instructions.
To use the Start screen:

1. On the Start screen, point to the far-right upper or lower corner of the screen to display the
charms.

2. Click Settings.
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3. Click Change PC settings in the bottom-right corner of the screen, and then select General
from the PC settings screen.

4. Under Remove everything and reinstall Windows, select Get started, and follow the on-
screen instructions.

Using HP Software Setup

HP Software Setup can be used to reinstall drivers or select software that has been corrupted or
deleted from the system.

1. From the Start screen, type HP Software Setup, and select Apps.
2. Open HP Software Setup.

3. Follow the on-screen directions to reinstall drivers or select software.
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12 Computer Setup (BIOS) and Advanced
System Diagnostics

Using Computer Setup

Computer Setup, or Basic Input/Output System (BIOS), controls communication between all the input
and output devices on the system (such as disk drives, display, keyboard, mouse, and printer).
Computer Setup includes settings for the types of devices installed, the startup sequence of the
computer, and the amount of system and extended memory.

@NOTE: Use extreme care when making changes in Computer Setup. Errors can prevent the
computer from operating properly.

Starting Computer Setup

=~?NOTE: An external keyboard or mouse connected to a USB port can be used with Computer Setup
only if USB legacy support is enabled.

To start Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

2. Press f10 to enter Computer Setup.

Navigating and selecting in Computer Setup

To navigate and select in Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

e To select a menu or a menu item, use the tab key and the keyboard arrow keys and then
press enter, or use a pointing device to click the item.

e  To scroll up and down, click the up arrow or the down arrow in the upper-right corner of the
screen, or use the up arrow key or the down arrow key.

e To close open dialog boxes and return to the main Computer Setup screen, press esc, and
then follow the on-screen instructions.

E‘%NOTE: You can use either a pointing device (TouchPad, pointing stick, or USB mouse) or the
keyboard to navigate and make selections in Computer Setup.

2. Press f10 to enter Computer Setup.

98 Chapter 12 Computer Setup (BIOS) and Advanced System Diagnostics



To exit Computer Setup menus, choose one of the following methods:
e To exit Computer Setup menus without saving your changes:

Click the Exit icon in the lower-left corner of the screen, and then follow the on-screen
instructions.

Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and then press
enter.

e To save your changes and exit Computer Setup menus:

Click the Save icon in the lower-left corner of the screen, and then follow the on-screen
instructions.

Use the tab key and the arrow keys to select File > Save Changes and Exit, and then press
enter.

Your changes go into effect when the computer restarts.

Restoring factory settings in Computer Setup

E’%NOTE: Restoring defaults will not change the hard drive mode.

To return all settings in Computer Setup to the values that were set at the factory, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

Press f10 to enter Computer Setup.
Use a pointing device or the arrow keys to select File > Restore Defaults.

Follow the on-screen instructions.

o » w b

To save your changes and exit, click the Save icon in the lower-left corner of the screen, and
then follow the on-screen instructions.

Use the arrow keys to select File > Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.

E’%NOTE: Your password settings and security settings are not changed when you restore the factory
settings.
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Updating the BIOS

Updated versions of the BIOS may be available on the HP website.
Most BIOS updates on the HP website are packaged in compressed files called SoftPags.
Some download packages contain a file named Readme.txt, which contains information regarding
installing and troubleshooting the file.
Determining the BIOS version

To determine whether available BIOS updates contain later BIOS versions than those currently
installed on the computer, you need to know the version of the system BIOS currently installed.

BIOS version information (also known as ROM date and System BIOS) can be displayed by pressing
fn+esc (if you are already in Windows) or by using Computer Setup.

1. Start Computer Setup.
2. Use a pointing device or the arrow keys to select File > System Information.

3. To exit Computer Setup without saving your changes, click the Exit icon in the lower-left corner
of the screen, and then follow the on-screen instructions.

Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and then press
enter.

Downloading a BIOS update

ACAUTION: To reduce the risk of damage to the computer or an unsuccessful installation, download
and install a BIOS update only when the computer is connected to reliable external power using the
AC adapter. Do not download or install a BIOS update while the computer is running on battery
power, docked in an optional docking device, or connected to an optional power source. During the
download and installation, follow these instructions:

Do not disconnect power on the computer by unplugging the power cord from the AC outlet.
Do not shut down the computer or initiate Sleep.

Do not insert, remove, connect, or disconnect any device, cable, or cord.

1. From the Start screen, type h and then select Help and Support.

2. Inthe Help and Support search box, type maintain, and then follow the on-screen
instructions to identify your computer and access the BIOS update you want to download.

3. At the download area, follow these steps:

a. Identify the BIOS update that is later than the BIOS version currently installed on your
computer. Make a note of the date, name, or other identifier. You may need this information
to locate the update later, after it has been downloaded to your hard drive.

b. Follow the on-screen instructions to download your selection to the hard drive.

Make a note of the path to the location on your hard drive where the BIOS update is
downloaded. You will need to access this path when you are ready to install the update.

=»NOTE: If you connect your computer to a network, consult the network administrator before
installing any software updates, especially system BIOS updates.
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BIOS installation procedures vary. Follow any instructions that are displayed on the screen after the
download is complete. If no instructions are displayed, follow these steps:

1. From the Start screen, type e, and then click File Explorer.
2. Double-click your hard drive designation. The hard drive designation is typically Local Disk (C:).

3. Using the hard drive path you recorded earlier, open the folder on your hard drive that contains
the update.

4. Double-click the file that has an .exe extension (for example, filename.exe).
The BIOS installation begins.

5. Complete the installation by following the on-screen instructions.

E‘/?"NOTE: After a message on the screen reports a successful installation, you can delete the
downloaded file from your hard drive.
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Using Advanced System Diagnostics

Advanced System Diagnostics allows you to run diagnostic tests to determine if the computer
hardware is functioning properly. The following diagnostic tests are available in Advanced System
Diagnostics:

System Tune-Up—This group of additional tests checks your computer to make sure that the
main components are functioning correctly. System Tune-Up runs longer and more
comprehensive tests on memory modules, hard drive SMART attributes, the hard drive surface,
the battery (and battery calibration), video memory, and the WLAN module status.

Start-up test—This test analyzes the main computer components that are required to start the
computer.

Run-in test—This test repeats the start-up test and checks for intermittent problems that the
start-up test does not detect.

Hard disk test—This test analyzes the physical condition of the hard drive, and then checks all
data in every sector of the hard drive. If the test detects a damaged sector, it attempts to move
the data to a good sector.

Memory test—This test analyzes the physical condition of the memory modules. If it reports an
error, replace the memory modules immediately.

Battery test—This test analyzes the condition of the battery and calibrates the battery if
necessary. If the battery fails the test, contact HP support to report the issue and purchase a
replacement battery.

BIOS Management—You can update or roll back the version of the BIOS on the system. Do not
shut down or remove external power during the process. You will be given a confirmation screen
before your BIOS is modified. Select BIOS update, BIOS Rollback, or Back to main menu.

You can view system information and error logs or select languages in the Advanced System
Diagnostics window.

To start Advanced System Diagnostics:

1.

2,

Turn on or restart the computer. While the “Press the ESC key for Startup Menu” message is
displayed in the lower-left corner of the screen, press esc. When the Startup Menu is displayed,
press 2.

Click the diagnostic test you want to run, and then follow the on-screen instructions.

=¥ NOTE: If you need to stop a diagnostics test while it is running, press esc.
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13 Support

Contacting support

If the information provided in this user guide or Help and Support does not address your questions,
you can contact support. For U.S. support, go to http://www.hp.com/go/contactHP. For worldwide
support, go to http://welcome.hp.com/country/us/en/wwcontact_us.html.

Here you can:

° Chat online with an HP technician.

@NOTE: When support chat is not available in a particular language, it is available in English.

e  E-mail support.
e  Find support telephone numbers.

° Locate an HP service center.
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Labels

The labels affixed to the computer provide information you may need when you troubleshoot system
problems or travel internationally with the computer:

e  Service label—Provides important information, including the following:

?

(O XIOXKKXXX
©—{ Serial: 000X IIININUANNIIMAINRY |
—Product: XXOOCOOXK [IINMIMERININRIIN

L Warranty: 1y1yOy
| Model: XXXXXXX

Component

1) Product name

(2) Serial number (s/n)

(3) Part number/Product number (p/n)
(4) Warranty period

(5) Model description

Have this information available when you contact support. The service label is affixed inside the
battery bay.

e Regulatory label—Provides regulatory information about the computer. The regulatory label is
affixed inside the battery bay.

e  Wireless certification label or labels (select models only)—Provide information about optional
wireless devices and the approval markings of some of the countries or regions in which the
devices have been approved for use. If your computer model includes one or more wireless
devices, one or more certification labels are included with your computer. You may need this
information when traveling internationally. Wireless certification labels are affixed inside the
battery bay.

e  SIM (subscriber identity module) label (select models only)—Provides the ICCID (Integrated
Circuit Card Identifier) of the SIM. This label is located inside the battery bay.

e HP Mobile Broadband Module service label (select models only)—Provides the serial number of
the HP Mobile Broadband Module. This label is located inside the battery bay.
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14 Specifications

° Input power

° Operating environment

Input power

The power information in this section may be helpful if you plan to travel internationally with the
computer.

The computer operates on DC power, which can be supplied by an AC or a DC power source. The
AC power source must be rated at 100-240 V, 50-60 Hz. Although the computer can be powered

from a standalone DC power source, it should be powered only with an AC adapter or a DC power
source supplied and approved by HP for use with this computer.

The computer can operate on DC power within the following specifications.

Input Power Rating

Operating voltage and current 185Vdc@3.5A-65W
19.5Vdc@3.33A-65W
19.0Vdc@4.74A-90W
19.5Vdc@4.62A-90W

@NOTE: This product is designed for IT power systems in Norway with phase-to-phase voltage not
exceeding 240 V rms.

E%NOTE: The computer operating voltage and current can be found on the system regulatory label.

Operating environment

Factor Metric u.s.
Temperature

Operating (writing to optical disc) 5°C to 35°C 41°F to 95°F
Nonoperating -20°C to 60°C -4°F to 140°F

Relative humidity (noncondensing)

Operating 10% to 90% 10% to 90%

Nonoperating 5% to 95% 5% to 95%

Maximum altitude (unpressurized)

Operating -15mto 3,048 m -50 ft to 10,000 ft

Nonoperating -“15mto 12,192 m -50 ft to 40,000 ft
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A Traveling with the computer

For best results, follow these traveling and shipping tips:
e  Prepare the computer for traveling or shipping:
° Back up your information.

° Remove all discs and all external media cards, such as digital cards.

/\ CAUTION: To reduce the risk of damage to the computer, damage to a drive, or loss of
information, remove the media from a drive before removing the drive from a drive bay and
before shipping, storing, or traveling with a drive.

° Turn off and then disconnect all external devices.
° Shut down the computer.
e Take along a backup of your information. Keep the backup separate from the computer.

e  When traveling by air, carry the computer as hand luggage; do not check it in with the rest of
your bags.

/\ CAUTION: Avoid exposing a drive to magnetic fields. Security devices with magnetic fields
include airport walk-through devices and security wands. Airport conveyer belts and similar
security devices that check carry-on baggage use X-rays instead of magnetism and do not
damage drives.

e In-flight computer use is at the discretion of the airline. If you plan to use the computer during a
flight, check with the airline in advance.

e If the computer will be unused and disconnected from external power for more than 2 weeks,
remove the battery and store it separately.

e If you are shipping the computer or a drive, use suitable protective packaging and label the
package “FRAGILE.”

e If the computer has a wireless device or an HP Mobile Broadband Module installed, such as an
802.11b/g device, a Global System for Mobile Communications (GSM) device, or a General
Packet Radio Service (GPRS) device, the use of these devices may be restricted in some
environments. Such restrictions may apply onboard aircraft, in hospitals, near explosives, and in
hazardous locations. If you are uncertain of the policy that applies to the use of a particular
device, ask for authorization to use it before you turn it on.

e If you are traveling internationally, follow these suggestions:

° Check the computer-related customs regulations for each country or region on your
itinerary.

° Check the power cord and adapter requirements for each location in which you plan to use
the computer. Voltage, frequency, and plug configurations vary.

/\ WARNING! To reduce the risk of electric shock, fire, or damage to the equipment, do not
attempt to power the computer with a voltage converter kit sold for appliances.
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B Troubleshooting

Troubleshooting resources

e  Access website links and additional information about the computer through Help and Support.
From the Start screen, type h, and then select Help and Support.

E/?’NOTE: Some checkup and repair tools require an Internet connection. HP also provides
additional tools that do not require an Internet connection.

e  Contact HP support. For U.S. support, go to http://www.hp.com/go/contactHP. For worldwide
support, go to http://welcome.hp.com/country/us/en/wwcontact_us.html.

Choose from the following types of support:

° Chat online with an HP technician.

E%NOTE: When chat is not available in a particular language, it is available in English.

° E-mail HP support.
° Find HP support worldwide telephone numbers.

° Locate an HP service center.

Resolving issues

The following sections describe several common issues and solutions.

The computer is unable to start up

If the computer does not turn on when you press the power button, the following suggestions may
help you determine why the computer does not start up:

e If the computer is plugged into an AC outlet, plug another electrical device into the outlet to be
sure that the outlet is providing adequate power.

@’NOTE: Use only the AC adapter provided with the computer or one approved by HP for this
computer.

e If the computer is plugged into an external power source other than an AC outlet, plug the
computer into an AC outlet using the AC adapter. Be sure that the power cord and AC adapter
connections are secure.
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The computer screen is blank

If the screen is blank but you have not turned off the computer, one or more of these settings may be
the cause:

e The computer may be in the Sleep state. To exit Sleep, briefly press the power button. Sleep is
an energy-saving feature that turns off the display. Sleep can be initiated by the system while the
computer is on but is not in use, or when the computer has reached a low battery level. To
change these and other power settings, right-click the Battery icon on the Windows desktop in
the notification area, at the far right of the taskbar, and then click Preferences.

e The computer may not be set to display the image on the computer screen. To transfer the
image to the computer screen, press fn+f4. On most models, when an optional external display,
such as a monitor, is connected to the computer, the image can be displayed on the computer
screen or the external display, or on both devices simultaneously. When you press fn+f4
repeatedly, the image alternates among the computer display, one or more external displays,
and simultaneous display on all devices.

Software is functioning abnormally

If the software is unresponsive or responds abnormally, restart the computer by pointing to the right
side of the screen. When the charms display, click Settings. Click the Power icon, and then click
Shut down. If you cannot restart the computer using this procedure, see the next section, The
computer is on but not responding on page 108.

The computer is on but not responding

If the computer is turned on but is not responding to software or keyboard commands, try the
following emergency shutdown procedures, in the sequence provided, until shutdown occurs:

/\ CAUTION: Emergency shutdown procedures result in the loss of unsaved information.

e Press and hold the power button for at least 5 seconds.

e Disconnect the computer from external power and remove the battery.

The computer is unusually warm

It is normal for the computer to feel warm to the touch while it is in use. But if the computer feels
unusually warm, it may be overheating because a vent is blocked.

If you suspect that the computer is overheating, allow the computer to cool to room temperature. Be
sure to keep all vents free from obstructions while you are using the computer.

/\ WARNING! To reduce the possibility of heat-related injuries or of overheating the computer, do not
place the computer directly on your lap or obstruct the computer air vents. Use the computer only on
a hard, flat surface. Do not allow another hard surface, such as an adjoining optional printer, or a soft
surface, such as pillows or rugs or clothing, to block airflow. Also, do not allow the AC adapter to
contact the skin or a soft surface, such as pillows or rugs or clothing, during operation. The computer
and the AC adapter comply with the user-accessible surface temperature limits defined by the
International Standard for Safety of Information Technology Equipment (IEC 60950).

@NOTE: The fan in the computer starts up automatically to cool internal components and prevent
overheating. It is normal for the internal fan to cycle on and off during operation.
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An external device is not working

Follow these suggestions if an external device does not function as expected:

e Turn on the device according to the manufacturer's instructions.

e Be sure that all device connections are secure.

e Be sure that the device is receiving electrical power.

e Be sure that the device, especially if it is older, is compatible with the operating system.

e Be sure that the correct drivers are installed and updated.

The wireless network connection is not working

If a wireless network connection is not working as expected, follow these suggestions:

e To enable or disable a wireless or wired network device, right-click the Network Connection
icon on the Windows desktop in the notification area, at the far right of the taskbar. To enable
devices, select the check box from the menu option. To disable the device, clear the check box.

° Be sure that the wireless device is turned on.
e Be sure that the computer wireless antennas are free from obstructions.

e Be sure that the cable or DSL modem and its power cord are properly connected and that the
lights are on.

e Be sure that the wireless router or access point is properly connected to its power adapter and to
the cable or DSL modem, and that the lights are on.

e Disconnect and then reconnect all cables, and turn the power off and then back on.
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The optical disc tray does not open for removal of a CD or DVD
1. Insert the end of a paper clip (1) into the release access in the front bezel of the drive.

2. Press in gently on the paper clip until the disc tray is released, and then pull out the tray (2) until
it stops.

3.  Remove the disc (3) from the tray by gently pressing down on the spindle while lifting the outer
edges of the disc. Hold the disc by the edges and avoid touching the flat surfaces.

E’%NOTE: If the tray is not fully accessible, tilt the disc carefully as you remove it.

R it

r""#ﬂ‘

4. Close the disc tray and place the disc in a protective case.
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The computer does not detect the optical drive

If your operating system does not detect an installed device, the device driver software may be
missing or corrupted.

1. Remove any discs from the optical drive.

2. From the Start screen, type c, select Control Panel, and then click System and Security.
3. Click Devices and Printers, and then click Device Manager.

4. In the Device Manager window, click the triangle next to DVD/CD-Rom drives. If the drive is

listed, it should be functioning correctly.

A disc does not play

e  Save your work and close all open programs before playing a CD or a DVD.
e Log off the Internet before playing a CD or a DVD.
e Be sure that you insert the disc properly.

e Be sure that the disc is clean. If necessary, clean the disc with filtered water and a lint-free cloth.
Wipe from the center of the disc to the outer edge.

e Check the disc for scratches. If you find scratches, treat the disc with an optical disc repair kit
available at many electronics stores.

e Disable Sleep mode before playing the disc.

Do not initiate Sleep while playing a disc. Otherwise, you may see a warning message asking if
you want to continue. If this message is displayed, click No. After you click No, the computer
may behave in either of the following ways:

° Playback may resume.

° The playback window in the multimedia program may close. To return to playing the disc,
click the Play button in your multimedia program to restart the disc. In rare cases, you may
need to exit the program and then restart it.

A movie is not visible on an external display

1. If both the computer display and an external display are turned on, press fn+f4 one or more
times to switch between the 2 displays.

2. Configure the monitor settings to make the external display primary:

a. From the Windows desktop, right-click on a blank area of the computer desktop, and select
Screen resolution.

b. Specify a primary display and a secondary display.

@NOTE: When using both displays, the DVD image will not appear on any display designated as
the secondary display.
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The process of burning a disc does not begin, or it stops before
completion

e Be sure that all other programs are closed.

e  Turn off Sleep mode.

e  Be sure that you are using the right kind of disc for your drive.
e Be sure that the disc is inserted properly.

e  Select a slower write speed and try again.

e If you are copying a disc, save the information on the source disc to your hard drive before trying
to burn the contents to a new disc, and then burn from your hard drive.
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Electrostatic discharge

Electrostatic discharge is the release of static electricity when two objects come into contact—for
example, the shock you receive when you walk across the carpet and touch a metal door knob.

A discharge of static electricity from fingers or other electrostatic conductors may damage electronic
components. To prevent damage to the computer, damage to a drive, or loss of information, observe
these precautions:

If removal or installation instructions direct you to unplug the computer, unplug it after being
properly grounded and before removing a cover.

Keep components in their electrostatic-safe containers until you are ready to install them.
Avoid touching pins, leads, and circuitry. Handle electronic components as little as possible.
Use nonmagnetic tools.

Before handling components, discharge static electricity by touching an unpainted metal surface
of the component.

If you remove a component, place it in an electrostatic-safe container.

If you need more information about static electricity or assistance with component removal or
installation, contact HP support.
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Symbols/Numerics
1394 cable, connecting 53
1394 devices
connecting 53
defined 52
removing 53
1394 port, identifying 11

A
AC adapter, testing 46
accessory battery connector,
identifying 14
administrator password 74
advanced system diagnostics
102
airport security devices 56
antivirus software 80
audio functions, checking 35
audio-in (microphone) jack,
identifying 10
audio-out (headphone) jack,
identifying 10
Automatic DrivelLock password
entering 79
removing 80

B
Backup and Restore 93
battery
conserving power 44
discharging 42
displaying remaining charge
42
disposing 44
low battery levels 42
replacing 45
storing 44
battery bay 104
battery bay, identifying 14
Battery Check 42
battery information, finding 42
battery light 9
battery power 41
battery release latch 14
battery temperature 44

114 Index

battery, replacing 43
BIOS

determining version 100
downloading an update 100
updating 100
Bluetooth compartment,
identifying 15
Bluetooth device 16, 21
Bluetooth label 104
buttons

calculator 6

center pointing stick 4
center TouchPad 4
left pointing stick 4
left TouchPad 4
media 34

optical drive eject 10
power 6, 39

right pointing stick 4
right TouchPad 4
volume 34

C
cables

1394 53

eSATA 54

USB 52
calculator button, identifying 6
calculator light 5
caps lock light, identifying 5
caring for your computer 91
checking audio functions 35
cleaning your computer 91
components

bottom 14

display 13

front 9

left side 11

rear 12

right side 10

top 4
computer reset 96
Computer Setup

BIOS administrator password

75

DriveLock password 77

navigating and selecting 98

restoring factory settings 99
computer, traveling 44, 106
configuring

ExpressCards 48
connecting to a WLAN 19
connector, docking 55
connector, power 12
conservation, power 44
corporate WLAN connection 19
critical battery level 39
critical updates, software 81

D
digital card

inserting 47

removing 47

supported formats 47
Disk Cleanup software 66
Disk Defragmenter software 66
display image, switching 31
display release latch 9
DisplayPort, connecting 37
DisplayPort, identifying 11
docking connector 55
docking connector, identifying 14
drive media 39
DriveLock password

changing 78

description 77

entering 78

removing 79

setting 77
drives

external 55

handling 56

hard 55

optical 55

using 56

E
electrostatic discharge 113
eSATA cable, connecting 54



eSATA devices

connecting 54

defined 53

removing 54
eSATA port 11
esc key, identifying 8
ExpressCard

configuring 48

defined 48

inserting 49

removing 50

removing insert 49
external AC power, using 45
external devices 54
external drive 55
external monitor port 10, 36
F
f11 recovery 95
Face Recognition 35
face recognition 73
fingerprint reader 82
fingerprint reader, identifying 7
firewall software 80
fn key, identifying 8, 31
function keys, identifying 8

G
GPS 21

H
hard drive
bracketremoval 0 , O
external 55
HP 3D DriveGuard 66
installing 62
removing 60
hard drive light 9, 67
hard drive recovery 95
hard drive, identifying 15
headphone (audio-out) jack 10
Hibernation

exiting 40
initiating 40
hot keys

adjusting volume 32
decrease screen brightness

32
decreasing speaker sound 32
description 31
increase screen brightness 32

increasing speaker sound 32
keyboard backlight 32
Sleep 31
switching screen image 31
using 31
hot keys, media 34
HP 3D DriveGuard 66
HP Mobile Broadband, disabled
20
HP ProtectTools Security
Manager 81
hubs 51

I

input power 105

integrated numeric keypad,
identifying 8, 33

integrated webcam light,
identifying 13

internal display switch 13

internal microphones, identifying
13

Internet connection setup 18

issues, resolving 107

J
jacks
audio-in (microphone) 10
audio-out (headphone) 10
network 11
RJ-11 (modem) 12
RJ-45 (network) 11
Java Card
defined 50
inserting 51
removing 51

K
keyboard backlight 32
keyboard hot keys, identifying 31
keypad

integrated numeric 8
keypad, external

num lock 33

using 33
keypads, identifying 33
keys

esc 8

fn 8

function 8

media 34

volume 34
Windows applications 8
Windows logo 8

L
labels
Bluetooth 104
HP Mobile Broadband
Module 104
regulatory 104
serial number 104
SIM 104
wireless certification 104
WLAN 104
latches, battery release 14
legacy support, USB 98

lights

battery 9

calculator 5
caps lock 5
hard drive 9
numlk 5

power 5,9
TouchPad 5
webcam 13
wireless 5

lights, hard drive 67
low battery level 42

M
maintenance
Disk Cleanup 66
Disk Defragmenter 66
media activity controls 34
Media Card Reader, identifying 9
media hot keys 34
memory module
identifying 15
inserting 84
removing 83
replacing 83
microphone (audio-in) jack,
identifying 10
mouse, external
setting preferences 24

N

network jack, identifying 11
num Ik key, identifying 33
num lk light 5

num lock, external keypad 33
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o
operating environment 105
optical disc

inserting 68

removing 69
optical drive 55
optical drive eject button,
identifying 10
optional external devices, using
54

P
passwords
administrator 74
BIOS administrator 75
DriveLock 77
user 74
pinching TouchPad gesture 27
pointing devices, setting
preferences 24
pointing stick 4
ports
1394 11
DisplayPort 11, 37
external monitor 10, 36
uUse 11
USB charging 11
VGA 36
power
battery 41
conserving 44
options 39
power button 39
power button, identifying 6
power connector, identifying 12
power lights 5, 9
power switch 39
power-saving states 39
product name and number,
computer 104
public WLAN connection 19

R
RAID 72
readable media 39
recovery 96
recovery partition 95
recycle

computer 96
refresh 96
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regulatory information
regulatory label 104
wireless certification labels
104
remove everything and reinstall
Windows 96
reset
computer 96
steps 96
restoring the hard drive 95
RJ-11 (modem) jack, identifying
12
RJ-45 (network) jack, identifying
11
rotating TouchPad gesture 27

S

screen brightness keys 32
screen image, switching 31
scrolling TouchPad gesture 26

security cable slot, identifying 11

security, wireless 18
serial number 104
serial number, computer 104
service door 15
service door, removing or
replacing 57
setting password protection on
wakeup 41
setting power options 39
setup of WLAN 18
setup utility
navigating and selecting 98
restoring factory settings 99
sharing optical drives 72
shutdown 39

SIM
inserting 20
SIM slot, identifying 14
Sleep
exiting 40
initiating 40
slots
security cable 11
SIM 14
smart card
defined 50
inserting 51

removing 51

smart card reader, identifying 10

SoftPags, downloading 92
software
antivirus 80
critical updates 81
Disk Cleanup 66
Disk Defragmenter 66
firewall 80
storing a battery 44
switch, power 39

T
temperature 44
testing an AC adapter 46
TouchPad
buttons 4
on/off button 7
using 24
TouchPad gestures
pinching 27
rotating 27
scrolling 26
zooming 27
TouchPad light, identifying 5
TouchPad zone
identifying 4
traveling with the computer 44,
104, 106
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Windows
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reinstall 96
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Windows 8 operating system
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wireless controls
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